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1 ABOUT

This is the User Guide for ParaMagic® 18.0 plugin for MagicDraw/SysML 17.0.5 and above. The
sections in this document and their purpose are stated below:

New Features in ParaMagic® 18.0

Quick Start — speed up learning ParaMagic® (run existing models, create new models)

Installation — installation instructions for ParaMagic®

User Documents — important documents for using ParaMagic® (including tutorials and examples)
SysML Model Requirements — requirements for creating SysML models executable in ParaMagic®
Program Features — learn about the ParaMagic® plugin user interface

Connections to External Solvers — learn about incorporating Mathematica functions, MATLAB
functions/scripts & Simulink models, and Excel spreadsheets as part of SysML parameteric models,
and using ParaMagic to execute parametric models that require multiple solvers

Trade Studies — learn to setup and run trade studies using ParaMagic®

ParaMagic® Silent — learn to run ParaMagic® in silent mode and invoke it in from your own plugins

Updates — learn about key user-oriented updates since the last release

Copyright —important copyright information that users must read

Copyright © 2014 InterCAX LLC. All Rights Reserved. 4
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ParaMagic® comes in two editions—ParaMagic® Lite and ParaMagic®. The table below compares the
features of these editions. All features (both editions) are described in this Users Guide. Features
highlighted in red are new in this release.

Features PM Lite PM

1) Regular math solving Yes Yes
Library of math functions available

2) Use Mathematica / PlayerPro (bundled®) / OpenModelica (free) / Yes Yes
MATLAB Symbolic Math Toolbox as a core solver

3) ParaMagic® Silent No Yes
Java API methods to call ParaMagic® in silent mode from your plugins
and scripts to validate, solve, and update SysML models with results

4) Read/Write SysML instance values from/to Excel spreadsheets Yes Yes
Connect SysML instances to Excel spreadsheets and read/write from/to
spreadsheets.

5) Generate & update SysML instance model from Excel spreadsheets No Yes

Automatically generate and update SysML instance models from tables
in Excel spreadsheets.

6) Trade Studies Yes Yes
Execute parametric model to perform trade studies

7) MATLAB/Simulink Connection No Yes
Wrap MATLAB functions/scripts as constraint blocks and use in
parametric models

8) Custom Mathematica Connection No Yes
Wrap custom Mathematica functions as constraint blocks and use in
parametric models

9) Complex Aggregates (see section 6.8) No Yes
Solve parametric models with complex aggregate relationships.

10) Recursion and Redefinition (see section 6.9) Yes Yes
Solve parametric models with recursive structures and implicit/explicit
redefinition of properties

! ParaMagic® 18.0 comes bundled with PlayerPro math solver (Wolfram Research). Current users can upgrade to
ParaMagic®+PlayerPro bundled installation for a one-time nominal fee.

Copyright © 2014 InterCAX LLC. All Rights Reserved. S
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The following conventions are followed in this document:

ParaMagic® implies this ParaMagic® 18.0 plugin

MagicDraw SysML implies MagicDraw UML + MagicDraw SysML plugin

Text enclosed by < > implies that you need to provide your system-specific settings, such as
installation directory path or IP address.

Text written in this font implies that it is a computer keyword or an abbreviation for a computer
keyword.

MD implies MagicDraw

<MD_Root> refers to the MagicDraw installation directory

(e.g. C:\Program Files\MagicDraw_UML_17.0.5 on a Windows machine).

OM implies OpenModelica

MATLAB SMT implies MATLAB Symbolic Math Toolbox

MagicDraw? is a registered trademark of No Magic, Inc.

Mathematica“ is a registered trademark of Wolfram Research, Inc.

MATLAB? and Simulink® are registered trademarks of The MathWorks, Inc.

OpenModelica’ is a freely-available modeling and simulation tool as part of the OpenModelica Project
supported by the Open Source Modelica Consortium (OSMC).

PlayerPro® is a registered trademark of Wolfram Research, Inc.

2 MATLAB Symbolic Math Toolbox: http://www.mathworks.com/products/symbolic/
3 MagicDraw: http://www.magicdraw.com

* Mathematica (Wolfram Research): http://www.wolfram.com/

> MATLAB (The MathWorks) - http://www.mathworks.com/products/matlab/

® Simulink (The MathWorks) - http://www.mathworks.com/products/simulink/

" OpenModelica - https://openmodelica.org/

8 PlayerPro - http://www.wolfram.com/player-pro/
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2 NEWwW FEATURES

The following new features are introduced in ParaMagic® 18.0:

1. Availability of ParaMagic® + Wolfram Player Pro bundle
With ParaMagic® 18.0, Wolfram Player Pro is available bundled with ParaMagic® at a very low
incremental price. All of ParaMagic’s advanced parametric solving capabilities are currently (and in
future) available with Player Pro. The option to select Player Pro is now available in the ParaMagic
Settings category under MagicDraw Environment Option (Options > Environment), as shown below.
We highly recommend all our users who were not using Mathematica earlier to upgrade to this bundle
to explore the full power of ParaMagic®.

ParaMagic Settings
B s [=] = =
B Core solver and other settings -
+ [ S iathenatia [ Flaver o -
Working Directory Mathematica [ Player Pro
Solver Timeout CpenModelica
MATLAB M-File Default Location MATLAB_SMT
Browser Display Predsion -1
Show Stats [] false
Mathematica Kernel Ci'\Program Files\Wolfram Research\Wolfram ... =

2. Availability of ParaMagic® + Mathematica bundle
While Player Pro serves as an advanced math solver for ParaMagic®, users may still need the full
power of Mathematica front end, such as the ability to work with Mathematica notebooks, advanced
user interface for authoring custom Mathematica functions and scripts, access to Mathematica library
and documentation, and the ability to test and debug Mathematica functions before using them in
SysML parametric models. Users can also purchase Mathematica® bundled with ParaMagic® at a
discounted incremental price.

3. ParaMagic® Silent (Java API) - Invoke ParaMagic in silent mode from your own plugins
ParaMagic® 18.0 comes with the ParaMagic® Silent feature which provides two main capabilities for
automation: (1) ParaMagic® Silent provides Java APl methods to validate and solve parametric
models, and update SysML instance models with results. Users who have installed the ParaMagic®
plugin can now invoke these APl methods from their own plugins; (2) ParaMagic® Silent also enables
users to solve parametric models and update SysML instance models without launching the
ParaMagic® browser interface. See section 10 for details on ParaMagic® Silent.

Copyright © 2014 InterCAX LLC. All Rights Reserved. 7
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Significant improvement in solving speed with PlayerPro and Mathematica

ParaMagic® 18.0 comes with a strong integration with Player Pro and Mathematica, communicating
directly with the math kernel versus the file-based communication earlier. This offers significant
improvements in solving speeds, especially for parametric trade studies executing 1000s of scenarios,
and significant reduction in the communication overhead with Mathematica and PlayerPro solver
engines.

Support for binding connectors between constraint parameters

ParaMagic® 18.0 now supports binding connectors between two constraint parameters, as shown
below. This works for all types of constraint blocks, those with regular math equations as well as
those wrapping externally defined MATLAB functions/scripts and Mathematica functions, as shown
below.

inputl - Real input2 - Real

«constraints
matlab? : xfwExternal_Matlab_Script

& Real :I cconstraints . . . . . . {output=xfw External(matlab,scriptasciiannualcyclescript.input1 input2)}
. subt : Sub . . . . . .
. {c=a-b} . . . . . . |—|
0 D"Réa'\j ciReal s s med [ wconstamt ] ; ; ; T Duteot - Resl B3: Real[1.]
. . :‘ mult1 : Mult .
: fceargy |

: [B83:Real L Re"-'j ‘Re

.\np.u.ﬂ - Real L input2 © Real

«constraint»
. . mathem atica : cMathematica_Function
<o | {output=cMathe matica{Userfn1,inputl.input2)} |- -

........ |

Fmpul :Real

Improved error handling and user messages when validating parametric models
ParaMagic® 18.0 comes with major improvements in handling errors and description of end user
messages when validating parametric models.

Improved support for MATLAB connection and messages
ParaMagic® 18.0 also provides major improvements in error handling and end user messages for the
MATLAB/Simulink connection (section 8.3).

Resolution of issues

In addition to the new and improved capabilities listed above, ParaMagic® 18.0 also resolves several
issues, such as those related to: (1) reading/writing nested instance structure from/to Excel
spreadsheets and (2) naming binding connectors and properties owned by blocks in read-only mode.

New ParaMagic® Icon
ParaMagic® has a new icon @. The new icon will show up in the ParaMagic® toolbar, browser,
settings, and dialogs.

8] MagicDraw 18.0 - Satellite-mdzip [C: jicDraw_18 gic\Tutorials\] - ‘ l’ R = ——
— — araMagic(R) 18.0 - satelliteSystem
Fle Edt View Layout Diagrams Options Tools Analyze Colaborate Window Help —— a gic(R)
- g o= . B o I
ODRE-D8 8B -5 - %5 8y [(hcetdagan DIEO 1 Name
Tz Containment | & Structure | 38 Diagrams [ Satellite BOD X | [f Satelite REQ Satelite PAR sdelite [Paraiiagisl SateliteSystem
B eExl e iR IR AU R PTET Y £ mass
Bwa & -
L Tools
5 Date ‘l (e | bdd [Package] Satelite | Satelite BOD f L] mass_MOS

Copyright © 2014 InterCAX LLC. All Rights Reserved. 8
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3 QUICK START

3.1 First Pass — execute existing models

In this section, you will learn to execute two existing ParaMagic® models.

e The first model (Addition) is a basic model for testing ParaMagic® installation. In this model, a
system variable is computed by adding two sub-system variables.

e The second model (Satellite) represents a simple satellite. It exercises basic SysML block definition
and parametric modeling concepts and is thus useful for learning SysML parametrics.

Follow the steps below to get started.
1) Install ParaMagic® — see installation instructions in Section 3 below.

2) Open and execute the Addition model

a) Start MagicDraw

b) Open the Addition model located here:
<MD_Root>\samples\ParaMagic\Tutorials\Addition.mdzip

c) Locate the package Addition::AdditionInstance01.

d) Right click on the package and select ParaMagic > Browse. This will launch the ParaMagic®
browser, as shown in Figure 1.

e) Click the solve button. After successful solution, the value of C (target variable) should equal to
3.

,

| Mame Qualified Name Type Causality  Values

Mnddiﬁon: :Addition Instance01::gammall Gamma

LW e Real target FrrErd
EHII alpha Addition::Addition Instance01::alphadl  Alpha

. L[Ta Real given 1
EHII beta Addition:: Addition Instance01::beta0l  Beta

] ] Real given 2

[ Expand ” Collapse all ] Reset Preserve Refs

root ( Gamma )

Name Local Rede... Relation Active
sum1 |Y | |c=alpha.a+be13.b |

Figure 1: ParaMagic® browser showing Addition model instance (solved state)

Copyright © 2014 InterCAX LLC. All Rights Reserved. 9
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3)

Note: You should have configured a core solver during installation (Section 3). If you have not
installed PlayerPro or Mathematica or OpenModelica (free) or MATLAB SMT, you can use our test
Mathematica server for a trial period (30 days). For this, you will need an internet connection. It is
possible that your enterprise firewall may block connection to our server.

Open and execute the Satellite model

a) Open the Satellite model located here: <MD_Root>\
samples\ParaMagic\Tutorials\Satellite.mdzip

b) Locate the package Satellite::Instance01.

c) Right click on the package and select ParaMagic > Browse.

d) Click on the Expand button to expand the model.

e) Click on the Solve button. After solving, the ParaMagic® browser will show results as in Figure 2
below. The value of target variables should be as follows:
i) SatelliteSystem.Power_MO0S=0.15
ii) SatelliteSystem.Weight_M0S=0.05

,
G rroett 120 ek B N e

Qualified Name Type Causality Values

SateliteSystem Satelite::Instance 1::satelites. .. SateliteSystem
-] mass Kilogram ancillary
-] mass_MOS Real target
{1 power_MOS Real target
Satellite::Instancel 1::satelites. .. Control
Kilogram given
Kilowatt given
Satellite::Instancel 1::satelites. . . Instrumentation
Kilogram given
Kilowatt given
Satelite::Instance 1::sateliites. .. PowerSystem
Kilogram given
Kilowatt ancillary
Satelite::Instancen 1::sateliteS. .. Propulsion
Kilogram given
Kilowatt given

[ Expand ” Collapse Al ] Solve DPreserve Refs

root { SateliteSystem )

Name Local Redef... Relation

mass_MOS={100-mass)/100

mass=propulsion. mPro +Hnstrumentation.mIns +control. mCon +powerSy. ..
power _MOS=(10-powerSystem.pPow) 10

powerSystem, pPow=propulsion. pPro-Hnstrumentation, pIns+control.p...

m_maos1
mbal1
p_mosl
pdem1

u
u
u
u

===

Figure 2: ParaMagic® browser showing Satellite model instance (solved state)

3.2 Second Pass — create new models

It is useful to identify several types of users who work with SysML parametrics:

Type 1: Someone who works with an existing model, including executing it and performing

additional instance-oriented interactions such as solving, modifying values, changing causalities, and

re-solving.

o This type of user needs the least amount of SysML and parametrics know-how.

o This a good place to start for the casual user, for someone wanting to do basic demos, or someone
just beginning to explore SysML parametrics.

Type 2: Someone who modifies the structure of an existing model and/or creates new instances.

o This type of user requires more know-how.

Copyright © 2014 InterCAX LLC. All Rights Reserved. 10
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o They also need a fair amount of MagicDraw SysML tool-aided modification support (in some
respects more than Type 3 users).
o This is a good step towards becoming a Type 3 user.
e Type 3: Someone who creates their own model structures and instances from scratch or from pre-
existing building blocks from a library.
o This type of user requires a fair amount of know-how and needs good MagicDraw SysML support.
e Type 4: Someone who creates building block libraries that Type 2 and Type 3 users can utilize.
o This type of user requires similar skills as Type 3, but with a bent towards making their work
reusable and modular, as well as providing good documentation and rigorous validation.

The First Pass in the previous section provided a quick introduction for Type 1 users. After completing
the First Pass, you can work at the Type 1 level with all the pre-built tutorial models and examples
provided in this release—see a listing of these models in Section 4 of this document.

After completing the First Pass, you also have a good “big picture” basis to now proceed with the step-by-
step tutorials (see section 5.2). After completing the tutorials, you will have achieved a good foundation
to work as a Type 3 user. There are other topics you may eventually need that may be addressed in future
tutorials and/or courses.

4  INSTALLATION

4.1 Installation Requirements

411 System Requirements

1) Operating system: ParaMagic® has been tested to work® with MagicDraw SysML (i.e. MagicDraw
UML + SysML plugin) installed on the following operating systems:
a) Windows 7 64-bit edition
b) Mac OS X 10.8.5 (Mountain Lion) 64-bit edition
¢) Linux-Ubuntu10.4LTS

2) Java: ParaMagic® requires Java 1.7 or higher'. ParaMagic® uses the same Java installation that is
being used by MagicDraw. To check the Java version used by MagicDraw, check that the value of the
JAVA HOME variable in <MD_Root>\bin\magicdraw.properties file points to Java 1.7 (JRE or
JDK 7) installation on your computer. For example, JAVA_HOME=C\:\\Program Files\\Java\\jre6
(or jre7)

3) Hard disk space: ParaMagic® requires 40 MB of hard disk space for installation.

4) RAM: ParaMagic® requires 500 MB of memory. Additional available RAM will improve the
performance of the plugin.

4.1.2 MagicDraw Requirements

1) ParaMagic® 18.0 requires MagicDraw SysML 17.0.5 (or higher).
2) ParaMagic® 18.0 has been tested to work with MagicDraw SysML 17.0.5 and 18.0.

® Unless otherwise specified, ParaMagic® may work with other editions of these OS but it is not been rigorously tested for
editions other than those mentioned here.

0 Note that ParaMagic® no longer supports Java 1.6. Oracle stopped releasing public updates for Java 1.6 in F 2013 -
http://www.oracle.com/technetwork/java/eol-135779.html

Copyright © 2014 InterCAX LLC. All Rights Reserved. 11


http://www.oracle.com/technetwork/java/eol-135779.html

ParaMagic® 18.0 e Users Guide

4.1.3 Core Solver Requirements

ParaMagic® allows users to select Mathematica / PlayerPro, OpenModelica™, or MATLAB SMT* as the
core solver—see section 4.2 (Step 3) for installation and configuration details. ParaMagic® has been
tested with Mathematica 9, PlayerPro 9, OpenModelica 1.9.0, and MATLAB/Simulink R2014a.

4.2 Installation Process

Before installing the ParaMagic® plugin, make sure that you have administrative privileges to install new
software on your computer. Follow the steps below to install ParaMagic® plugin.

Step 1. Start MagicDraw (MD) as Administrator

If you are running MD, close it. Start MD from a user account with admin privileges on your computer.
On Windows 7 you must run MD as an administrator to install/uninstall plugins even if you have admin
privileges on your account. To do this, right click on the MD application and select Run as administrator.

Step 2. Install the ParaMagic® plugin

a) If you do not have the ParaMagic® plugin installation (zip file),
i) On MD’s main menu bar, select Help > Resource/Plugin Manager
ii) Click on Check for Updates button
iii) You will see ParaMagic® plugin version 18.0 available for installation. Select this plugin.
iv) Click on Download / Install button to install the ParaMagic® plugin.
v) After installation, restart MD for the plugin to take effect.

b) If you have the ParaMagic® plugin installation (zip file),
i) Inthe main menu bar, select Help > Resource/Plugin Manager
ii) Click on the Import button and specify the location of the plugin zip file.
iii) After installation, you will need to restart MD for the plugin to take effect. It is suggested that you
finish all the steps below before restarting MD.
iv) After installation, restart MD for the plugin to take effect.

Step 3. Select the core solver for ParaMagic®
ParaMagic® allows users to select Mathematica / PlayerPro, OpenModelica®®, or MATLAB SMT as the
core solver. If you plan to use:

e Mathematica or PlayerPro as your core solver, follow steps in sub-section a below and then move to
Step 4.

o OpenModelica as your core solver, follow steps in sub-section b below and then move to Step 4.

o MATLAB SMT as your core solver, follow steps in sub-section ¢ below and then move to Step 4.

11 OpenModelica: https://openmodelica.org/
12 MATLAB Symbolic Math Toolbox: http://www.mathworks.com/products/symbolic/
13 OpenModelica: https://openmodelica.org/

Copyright © 2014 InterCAX LLC. All Rights Reserved. 12
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a) Using Mathematica or PlayerPro as your core solver

i)
i)

[

rl

i)

iv)

In MagicDraw, go to Options > Environment and select ParaMagic Settings, as shown in
Figure 3.

Set Core Solver variable to Mathematica / PlayerPro. If you do not see Mathematica /
PlayerPro option for the Core Solver but only see Mathematica, click on the Reset to
Defaults button at the bottom right hand corner of the Settings window.

ParaMagic Settings options
Change various ParaMagic Settings options and configurations.
""" E EF”EFE" ParaMagic Settings
----- iagram
----- % Browser 'E‘ 2 ';l E": E"X
""" E%l Composition Inspection Bl Core solver and other settings -
""" {7 Colaboration » N Mathematica /PlaverPo__ w |
""" oL CVS Working Directory Mathematica | Player Pro
----- &5 Update Solver Timeout OperModelica
% E::;g:: ’ MATLAB M-File Default Location MATLAB_SMT
X Browser Display Precision -1
----- = Plugins
_____ &) Resources Show Stats [ false
_____ P¥ Path Variables Mathematica | Player Pro Kernel C:\Program Files\Wolfram ResearchiWolfram ... |E
w speliing Log Message Level WARNING
..... [ Launchers ;| |El Local vs. Remote core solver
..... E Experience [ | Uselocal Solver true
----- [#] External Tools i Remote Solver - Host URL Xws.magicdraw. com: 3080
----- [=] Notifications Remote Solver - Access Key tempAccesskey
""" £ Code Engineering Remate Solver - Retry Limit 1 |
""" Document Madeling Remote Solver - Time between Retries 1000
""" <3=2' Edlipse UMLZ {v1.x) XML El Mac and Linux-specific settings =
----- = Edlipse UML2 {v2,x) XML
----- 3 Edlipse UML2 (v3.x) XML Core Solver
..... = Edipse UML2 {v4.x) XMI Solver used by ParaMagic for executing parametric relationships, except externally-defined
_____ £ Enterprise Architect Import functions. Select Mathematica [ Player Pro, OpenModelica, or MATLAB SMT as the core solver.
% Macros
Q Q> Type here to filter properties
----- Report Wizard
----- © st
[ OK ] [ Cancel ] [ Help ]

Figure 3: ParaMagic® Settings window

For short-term (30 day) evaluation, you can use our test Mathematica server. For long-term
production usage, you should use your own Mathematica license.

To use our test Mathematica server for short-term evaluation, follow the steps below. Note

that you will need an internet connection and your enterprise firewall may block connection

to the Mathematica server.

(1) In the ParaMagic Settings window (Figure 3) locate the second section — Local vs.
Remote core solver.

(2) Set Use Local Solver variable to false

(3) Check that the Remote Solver — Host URL variable is set to xws.magicdraw.com:8080

(4) Check that the Remote Solver — Access Key Vvariable is set to tempAccessKey

(5) Click OK and close the ParaMagic Settings window.
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v)

If you are using your own Mathematica or PlayerPro license, follow the steps below.

(1) Check that Mathematica or PlayerPro is installed correctly by trying to launch it from
your Start menu (Windows) or Finder (Mac).

(2) In MagicDraw, go to Options > Environment and select ParaMagic Settings, as shown in
Figure 3.

(3) Under the Core solver and other settings section, locate the Mathematica / PlayerPro
Kernel property.

(4) Click on the value field of the Mathematica / PlayerPro Kernel property and then select
the file chooser button, as highlighted in Figure 4. Browse and select the MathKernel
executable file.

(@)

(b)

(©)

For Windows 7, this is typically
C:\Program Files\Wolfram Research\Wolfram Player Pro\9.0\MathKernel.exe,

For Mac OS X, this is typically
/Applications/Wolfram Player Pro.app.app/Contents/MacOS/MathKernel.

For Linux, the Mathematica / PlayerPro Kernel property is not used, and hence does
not need to be populated.

However, a symbolic link (shortcut) /usr/local/bin/math must exist and point to the
math kernel that comes with Mathematica or PlayerPro. If you are using Mathematica
on Linux, this link is typically created by the Mathematica installation process and
must exist already. Verify the same. If you are using PlayerPro on Linux and don’t
have Mathematica installed, then this link will not exist and must be created using the
command below.

sudo In -s /usr/local/Wolfram/PlayerPro/9.0/Executables/math /usr/local/bin/math

The first path in the command (/usr/local/Wolfram/PlayerPro/9.0/ Executables/math) iS
the location of the math kernel file in the PlayerPro installation. If you have
PlayerPro installed in a different location, update this path in the command. The
second path in the command (/usr/local/bin/math) is the full path of the softlink that
will be created. Do not modify this. For more details on creating symbolic link, refer
to http://manpages.ubuntu.com/manpages/utopic/manl/In.1.html

(5) Under the Local vs. Remote core solver section, set Use Local Solver variable to true
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ParaMagic Settings

B8] o =] =2 =t
Bl Core solver and other settings -
Core Solver Mathematica / Player Pro
Working Directary C:\Users\Manas\AppDataiLocal\. magicdraw | 17.0. 5\plugins\com.i. ...
Solver Timeout -1
MATLAB M-File Default Location C:\Program Files\MagicDraw UML\samples\ParaMagic\Tutorials\Ho... | _
Browser Display Predsion -1 1
Show Stats [] false -
MMathematicakernel ~~ |ogram Files\Wolfram Research\Mathematica\g.0\Mathkernel.ex= BRI
i Log Message Level WARNING - 7
:| | Bl Local vs. Remote core solver
Use Local Solver true
Remote Solver - Host URL wws.magicdraw. com: 3080
Remote Solver - Access Key tempAccesskey S
Mathematica Kernel
This is the location of the Mathematica kernel file (Mathkernel) that comes with Mathematica or Player Pro. -
This location is needed only for Windows and Mac operating systems. For example C:Program FilesWolfram

ResearchWolfram Player Prog.0Mathkernel.exe on Windows and fApplications M alfram Player -

Type here to filter properties

Reset to Defaults

[ 0K ] [ Cancel ] [ Help ]

Figure 4: Click on the file chooser to specify the location of MathKernel executable file for
Mathematica or PlayerPro installation

(6) Click OK in the ParaMagic Settings window.

Note: Before using Mathematica (or PlayerPro) with ParaMagic®, users must launch Mathematica (or
PlayerPro) to verify that the product is activated and that the user has a valid license.

Using OpenModelica as your core solver
OpenModelica is a free Modelica-based modeling and simulation tool available as part of the
OpenModelica Project that is managed by the Open Source Modelica Consortium (OSMC).

i) Download and install OpenModelica 1.9.0

(1) Windows — Download and run the OpenModelica-1.9.0-revision-17628.exe file located here:
https://build.openmodelica.org/omc/builds/windows/releases/1.9.0/

(2) Mac — Download the openmodelica-devel-8719-tag-1.7.0.dmg file locate here:
http://build.openmodelica.org/omc/builds/mac/binaries/. OpenModelica on Mac requires
XCode. For details, see http://www.openmodelica.org/index.php/download/download-mac

(3) Linux — Follow the installation instructions located here:
https://openmodelica.org/index.php/download/download-linux

ii) In MagicDraw, go to Options > Environment and select ParaMagic Settings, as shown in Figure 5
below.
iii) Set Core Solver variable to OpenModelica.
iv) If you are on Mac OS, set the OpenModelica Installation Location variable (Figure 5) to the
location of omc file in your OpenModelica installation, for e.g. /opt/openmodelica/bin/omc.
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ParaMagic Settings

Bl o (= =2oe
Bl Core solver and other settings
Core Solver

Warking Directory
Solver Timeout
MATLAE M-File Default Location
Browser Display Predsion
Show Stats
Mathematica Kernel
Log Message Level

B Local vs. Remote core solver
Use Local Solver
Remote Solver - Host URL
Remote Solver - Access Key
Remote Solver - Retry Limit
Remote Solver - Time between Retries

Mathematica / Flayer Pro

Ci\Users\Manas \AppDataLocall. magicdraw. ..

-1

C:\Program Files\MagicDraw UML\samples'F...

-1

[] false

C:\Program Files\Waolfram Research\Mathe. ..
WARNIMG

true
¥ws.magicdraw. com; 3080
tempAccesskey

1

1000

Bl Mac and Linux-specific settings

» ioptiopenmodelcalpinlome

MATLAE Installation Location \Applications\MATLAE_2010b, app'binimatiab

OpenModelica Installation Location
Location of OpenModelica omc file on Mac Q5. This value is used only if core solver is set -«
to OpenModelica. This variable does not need to be set for Linux,

Type here to filter properties

[ Reset to Defaults ]

[ K ] [ Cancel ] [ Help ]

Figure 5: For Mac OS, set the variable OpenModelica Installation Location

v) If you are on Windows or Linux, you do not need to set anything else after installing
OpenModelica in step iii above.
vi) Click OK in the ParaMagic Settings window.

c) Using MATLAB Symbolic Math Toolbox (SMT) as your core solver

i) Ensure that MATLAB and Symbolic Math Toolbox are installed on your machine.

ii) In MagicDraw, go to Options > Environment and select ParaMagic Settings, as shown in Figure
5 above.

iii) Set Core Solver variable to MATLAB_SMT.

iv) If you are on Mac or Linux, set the MATLAB Installation Location Vvariable to the location of the
MATLAB executable file, for e.g. /Applications/MATLAB_R2014a.app/bin/matlab (for Mac) or
/home/intercax/MATLAB/R2014a/bin/matlab (for Linux)

v) If you are on Windows, you do not need to set anything else.

vi) Click OK in the ParaMagic Settings window.

Step 4. Close and Restart MagicDraw (MD) as an Administrator
After restarting MD, your installation is configured to use the ParaMagic® 18.0 plugin.
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Step 5. Test ParaMagic® installation

a) In MagicDraw, select Options > Environment. Select Plugins on the LHS, as shown in Figure 6
below, and click on the Provider column to sort the list by providers. You should see ParaMagic®
18.0 in the list of installed plugins. Verify that the Loaded and Enabled properties are set to true
for the ParaMagic® plugin.

b) Open and execute the Addition model and the Satellite model as shown in section 2 above.
i) During solution, ParaMagic® will indicate the core solver that is being used for solving.

Verify that this is same as the core solver your setup and selected in Step 3 above.

ii) Ensure that you get the same solution results as shown in section 2 (Figure 1 and Figure 2).

Plugins information
Review detailed information about all installed plugins.

Congratulations! You are now setup to use ParaMagic®.

5 USER DOCUMENTS AND MODELS

5.1 Users Guide

1) This document is the User Guide for ParaMagic® plugin
2) This Users Guide is also located here after installation:
<MD_Root>\manual\ParaMagic\Users_Guide.pdf

-5 General Plugins

% Diagram =

% Browser Name Provider Version Loaded  Enabled
/Y, Composition Inspection SLIM MagicDraw InterCAX  1.0.14  true true -
¢} Collaboration ParaMagic Dema InterCAX  18.0 true frue
-oiovs
('}0 Update SysML Mo Magic  18.05P2  true true

BB Network Project Composition Validation Rules Mo Magic 1.0 true frue =
= Kevuard Cameo Requirements Modeler Mo Magic  18.0 true frue

{ Relation Map Mo Magic 1.0 true true

() RESUL"E'_ES Generic model transformation Mo Magic 1.0 true true |4
- PY Path.\u'anablas Model migration framework No Magic 1.0 true frue

-4 Speling User Interface Modeling NoMagic 16,6 true true

m Launchers Sequence Diagram Generation from Java Source Mo Magic 2.0 true true

- B Experience  up-sell No Magic 1.0 true true

-~ [] External Tools | [Eclipse UML2 (v3.x) XMI Export/Import No Magic 1.0 true frue

= NUﬁﬁEﬂﬁ?”s Diagram Table Mo Magic 1.0 true true

Code Englneer\ng \Web UML diagram tools No Magic 2.0 true frue
Document Modeing _ Document Modeling Mo Magic 18.05P1 true frue

g- Eclipse UML2 (v1.) 'X_MI ECore Export No Magic 1.0 true true

: Edlipse UML2 (v2.x) XML Web report plugin NoMagic 1.0 true true

T Eclpse UML2 (v3.5) XM CORBA IDL pattarns and tools NoMagic 2.0 true true

- Edipse UML2 (v4.x) XML Copy diagram as image to Win32 dipboard Mo Magic 2.0 true frue

; inherprlse Architect Import Eclipse UML2 (v2.x) XMI Export/Import No Magic 3.1 frue frue -
acros

Q ParaMagic Settings l

Figure 6: Verify that ParaMagic® is listed as a plugin and Loaded and Enabled properties are set true

5.2 Tutorials

1) This installation comes with 8 tutorials. Each tutorial has step-by-step instructions to create a valid
SysML model that can be solved using this plugin. All tutorials are described in one document that is
located here: <MD_Root>\samples\ParaMagic\Tutorials\Tutorials.pdf

2) Each tutorial also has a pre-built SysML model with instances that are ready to explore, solve, and
perform trade studies on instance values. These models are located here:
<MD_Root>\samples\ParaMagic\Tutorials
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a) Addition is a SysML model for learning how to create basic parametric equations. Its tutorial
includes step-by-step instructions and demonstrates an addition operation applied to system
properties.

b) CommNetwork is a SysML model of a communication network system.

C) Electronics is a SysML model of a network architecture.

d) LittleEye is a SysML model of a UAV-based road scanning system named LittleEye.

e) LittleEyeTradeStudy is a SysML model to demonstrate ParaMagic’s trade study capabilities using
the LittleEye system model (above).

f) satellite is a SysML model of a satellite system.

g) Orbital is an early-stage orbital mechanics and spacecraft model in SysML that demonstrates the
use of ParaMagic-Excel connection (section 8.1) and ParaMagic-Custom Mathematica
connection (section 8.1).

h) HomeHeating is a SysML model of a home heating system that demonstrates the execution of
Simulink models using the ParaMagic-MATLAB connection (section 8.3). This model has been
tested to work with MATLAB 2014a.

5.3 Examples

1)

2)

3)

This installation comes with 11 example SysML models that are ready to explore, solve, and perform

trade studies on instance values.

These example SysML models are located here: <MD_Root>\samples\ParaMagic\Other_Examples.

A document describing these example models is located here:

<MD_Root>\samples\ParaMagic\Other_Examples\Other_Examples.pdf

The following example models are provided with ParaMagic™

i) Banking is a SysML model of a banking services system.

ii) Circuit is a SysML model of an electrical circuit and demonstrates the application of Ohm's Law.

iii) Financial is a SysML model of financial projections for a small business.

iv) Linkage Systems (formerly FlapLinkage) is a SysML model of mechanical linkage system—a
part used in an airframe structure. It demonstrates the use of SysML for modeling design
constraints as well as building block libraries and other modeling concepts. See item 0 below for
a corresponding paper (Part 2) that overviews the theory behind SysML parametrics as well as
applications to simulation templates.

V) Insurance is a SysML model of a web-based insurance claim filing system.

vi) OpAmp is a SysML model of an operational amplifier. By using the same constructs as in the
Circuit model, it demonstrates the reusability of concepts defined in SysML.

vii) ProjectPlan is a SysML model of a project scheduling system and demonstrates the use of
conditionals (if-then statements).

viii) SpringSystems is a SysML model of a system of two springs connected in series and exhibiting
linear deformation behavior. See item 0 below for a corresponding paper (Part 2) that overviews
the theory behind SysML parametrics as well as applications to simulation templates.

iX) Trade is a SysML model of a trade financing system.

X) VehicleMassRollup is a SysML model of a vehicle system and demonstrates how to model variant
architectures using recursion and redefinition and execute the same using ParaMagic®.

Xi) MATLAB_Example is a SysML model illustrating the different ways to connect to MATLAB
functions and scripts using ParaMagic®. See the package diagram Scripts and Functions for
details.

Note that the intent of the tutorial and example models is to present how SysML (Parametrics in
particular) can be used for different types of problems in different domains. Some models are created
for demonstration purposes only, and not intended to represent all aspects of the systems in the most
accurate manner.
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5.4 Relevant Publications

1) Bajaj, M., Zwemer, D., Peak, R., Phung, A., Scott, A. and Wilson, M. (2011). Satellites to Supply
Chains, Energy to Finance — SLIM for Model-Based Systems Engineering, Part 1: Motivation and
Concept of SLIM. 21st Annual INCOSE International Symposium, Denver, CO, June 20-23, 2011.
(available at http://www.omgsysml.org/SLIM_for_MBSE_Bajaj_Part1.pdf)

2) Bajaj, M., Zwemer, D., Peak, R., Phung, A., Scott, A. and Wilson, M. (2011). Satellites to Supply
Chains, Energy to Finance — SLIM for Model-Based Systems Engineering, Part 2: Applications of
SLIM. 21st Annual INCOSE International Symposium, Denver, CO, June 20-23, 2011. (available at
http://www.omgsysml.org/SLIM_for_ MBSE_Bajaj_Part2.pdf)

3) Peak, R.S., Roger M. Burkhart, Sanford A. Friedenthal, Wilson, M.W., Bajaj, M. and Kim, I. (2007).
Simulation-Based Design Using SysML Part 1: A Parametrics Primer. The Seventeenth International
Symposium of the International Council on Systems Engineering, San Diego, California, USA June
24 -28, 2007. (available at http://eislab.gatech.edu/pubs/conferences/2007-incose-is-1-peak-primer/)

4) Peak, R.S., Burkhart, R.M., Friedenthal, S.A., Wilson, M.W., Bajaj, M. and Kim, I. (2007).
Simulation-Based Design Using SysML Part 2: Celebrating Diversity by Example. The Seventeenth
International Symposium of the International Council on Systems Engineering, San Diego,
California, USA June 24 -28, 2007. (available at http://eislab.gatech.edu/pubs/conferences/2007-
incose-is-2-peak-diversity/)

6 SYSML MODEL REQUIREMENTS

This section consists of a list of modeling requirements that need to be satisfied to use the solver
capabilities of ParaMagic® plugin. Some of these requirements are based on recommended practices for
enhanced model interoperability; some are to make SysML models less ambiguous for the plugin and
Mathematica / PlayerPro / OpenModelica / MATLAB SMT solvers; while others are limitations of this
version of the plugin and/or supported solvers. These guidelines are followed in the tutorial examples
included with this installation. It is suggested that a user walks through the tutorials first and then review
these requirements for better understanding.

6.1 Structural requirements

These requirements deal with the model schema and instances created using SysML. In our terminology,
a schema defines the structure of the model using SysML constructs such as blocks, properties, and
constraint blocks; and an instance conforms to this structure and has populated slots (properties)—
completely or partially. There may be several instance models for a given schema. A system model
schema represents a family of system alternatives (topological or parametric variations) while a system
model instance represents a specific system alternative that is analyzed and evaluated.

6.1.1 Model schema requirements

1) ParaMagic® requires that all SysML elements required for defining the schema must be in packages.

2) If a constraint property (say c1) defined in a block has the same name as an inherited constraint
property, ParaMagic® will override the inherited constraint property with the constraint property ci.
Modelers can use this feature to define abstract constraint properties for a block that are implemented
or overridden by constraint properties of the block’s subtypes.
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6.1.2 Model instance requirements

1) Instance slots that correspond to block properties participating in parametric relations must be
initialized/populated unless the lower bound of the multiplicity for these properties is equal to 0
(zero). ParaMagic® provides capabilities to automatically initialize slots.

2) Instance slots corresponding to value properties can be populated by LiteralReal, Literallnteger, and
LiteralString value specifications.

3) All numeric values in instance slots must begin with a number (0-9). Values beginning with a space
or decimal point may not be read correctly.

4) If the value property corresponding to a slot is connected to the outputs of multiple ONEWAY
relations, then the slot must have causality “given”. This restriction is imposed to prevent instance
models from being over-constrained.

5) Causality Verification and Assignment: The truth table below states valid causality assignments for
slots in a SysML instance model. Causality can be set and is validated for only those slots whose
corresponding value properties participate in parametric relations. The validity of a causality
assignment is based on whether or not a slot has value(s). In the table, TRUE implies valid
assignments and FALSE implies invalid assignments. For example, if a slot has values and its
corresponding value property participates in parametric relations, then its causality may be given,
ancillary, or target but not undefined. Its causality may be ancillary or target only when the model is
in a solved state. Similarly, if a slot has no values (empty), then its causality may be undefined or
target but not given or ancillary.

Table 1: Truth table for valid causality assignments
causality
If a slot given undefined ancillary target
has values TRUE FALSE TRUE TRUE
does not have FALSE TRUE FALSE TRUE
values (empty)™

ParaMagic® checks for validity of causality assignments when users attempt to browse SysML
instance models in the ParaMagic® browser. The causality assignment utility in ParaMagic® that is
invoked on instance models (ParaMagic > Util > Add default causalities) assigns default causalities
based on this table.

6) Slots corresponding to value properties that are typed by Integer (or its subtype) should have causality
“given”, i.e. they can only be inputs to parametric calculations. ParaMagic® treats integers (only
allowed as inputs) as real numbers during solving.

6.2 Naming requirements

1) All SysML blocks, constraint blocks, and properties (part / reference / shared / value) should have a
name.

2) Block properties and constraint parameters should not have names that are reserved math keywords.
In addition to names of math constants and functions listed in section 5.4, the following names are
also reserved: binom, str.

3) All SysML model elements should have names that start with an alphabetical character (A-Z, a-z).

14 «“Empty” denotes that the slot (or slot value) has been activated but does not contain any value (i.e. its value is an empty string
and represented as a Literal String). Note that if the slot (or slot value) is not activated, then causality cannot be assigned to it

anyway.
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4) The allowable character classes for naming model elements are: A-Z, a-z, 0-9, underscore, and
whitespace.

5) Period (.) should not be used in naming model elements. Some of these limitations are due to math
parsers and solvers.

6.3 Mathematical expression requirements

1) Mathematical functions (e.g., min, exp) should begin with a lower-case letter and use standard
parentheses () to enclose their arguments.

2) A valid mathematical equation for ParaMagic® processing purposes is one that has a single variable
on the LHS. For example, a=b+c will be processed but users will face issues processing the same
equation defined as b+c=a.

3) The list of math operators supported™ in ParaMagic® are as follows:

a) Addition (+), Subtraction (-), Multiplication (*), Division (/)
b) Unary plus (+x), and Unary Minus (-x)

4) It is recommended that large expressions be broken into simpler expressions that are more readily
solvable by Mathematica / PlayerPro / OpenModelica / MATLAB SMT. For example, the expression
below

k = (0.577*3.14*E*d) / In(((1.15*t+D-d)*(D+d)) / ((1.15*t+D-d)*(D-d)))
can be broken into two expressions:

k = (0.577*3.14*E*d) / In(dummyVariable)
dummyVariable=((1.15*t+D-d)*(D+d)) / ((1.15*t+D-d)*(D-d))

Since ParaMagic® supports only one constraint expression per constraint block, this would require
you to create two constraint blocks (one for each expression) and to create a dummy value property
(corresponding to the dummyVariable) in the context block.

In general, the math expression syntax supported by ParaMagic® is based on JEP*® (with extensions).

6.4 Value types and QUDV profile

ParaMagic® requires that value properties and constraint parameters participating in parametric constraint

relations satisfy ONE OF the following requirements. Let the value type of the given value property (or

constraint parameter) be V. Then,

1. V should be the value type “Real” (SysML Profile::Blocks::Real) or its subtype, OR

2. V should be the value type “Integer” (SysML Profile::Blocks::Integer) or its subtype, OR

3. V should be a value type with the quantityKind field populated. Such a value type represents a
“quantity” which per SysML 1.3 can be measured (is quantifiable) using a number. See SysML 1.3
specification, section 8.3.2.10, page 50.

Requirement 3 above allows ParaMagic® users to leverage the standard value types now available with
the SI ValueType library in MagicDraw (QUDV Library::SI ValueType Library).

Note that value properties typed by String (SysML Profile::Blocks::String) are handled by ParaMagic® but
cannot participate in parametric relations.

1% Note that ParaMagic™ may not warn if other operators are used. Users should only use the math operators stated here.
16 JEP: http://www.singularsys.com/jep/
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ParaMagic® has the following limitations regarding value types:

1. Internally, ParaMagic® treats all value types obeying the requirements above as real numbers.

2. ParaMagic® does not check for the compatibility of value types (or constraint parameters) connected
using binding connectors. This verification is performed by MagicDraw. Hence, users should check
and resolve warnings and errors generated by MagicDraw when connecting value properties and/or
constraint parameters before launching ParaMagic®.

3. ParaMagic® does not perform automatic unit conversions.

The ParaMagic® browser only displays slots whose corresponding value properties are typed by Real,
Integer, String, or a value type representing a quantity, and their subtypes.

6.5 Math constants and functions

ParaMagic® currently supports the following math constants and functions in defining constraint
specifications of constraint blocks.

Some functions are not supported or have limited support if OpenModelica (OM) or MATLAB SMT is
selected as the core solver. These functions have comments in blue (for OpenModelica) and red (for
MATLAB SMT).

A list of constants is provided below.
Name Syntax Example

Pi(m) pi y =pi+X

A list of functions is provided below. In principle, several of these functions may be executed in different
causalities (directions)—computing LHS value(s) for a given set of RHS values, or computing RHS
value(s) for a given set of RHS and LHS values. In the current version of this plugin, these functions and
expressions containing these functions are verified to work reliably (i.e. give a correct answer) only in the
natural causality (computing LHS value from a given set of RHS values). Hence, these functions are
marked as ONEWAY by default when used in a MagicDraw model. If you would like to try solving a
function (or the expression it is being used in) in the reverse direction, uncheck the ONEWAY mark for
that function (or expression) in the Relationship Browser section of the ParaMagic browser (see Figure 33
in section 7.2) and press Solve. Note that this selection will not be stored in ParaMagic® settings. This
implies that when the browser is launched the next time, the ONEWAY marks for these functions need to
be unchecked again. The two primary reasons for marking these functions as ONEWAY by default are:

2) For large expressions involving several functions, Mathematica may not always return an answer
when these expressions are evaluated in non-natural directions.

3) The current version of ParaMagic® does not support inequalities. Without an inequality constraint,
some of the functions (esp. trigonometric functions) return a general solution instead of a specific
solution. For example x=sin(pi/2) will return the general solution x = 2*n*pi + pi/2. This limitation
will be addressed in future release(s) of ParaMagic®.

If OpenModelica is selected as the core solver, none of the functions are marked as ONEWAY. However,
this may result in an unexpected (but correct) answer if some of these functions are solved in different
directions (due to lack of support for inequalities). For example, solving 1=Sin(x) may not always return
x=1.570 (or pi/2).

Name Syntax Example
Sine sin(x) y =sin(x)
Cosine cos(x) y = cos(X)
Tangent tan(x) y = tan(x)
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less than or equal to the argument)

Arc Sine asin(x) y = asin(x)
Arc Cosine acos(x) y = acos(x)
Arc Tangent atan(x) y = atan(x)
Arc Tangent

(gives the arc tangent of y/x, taking into @ atan2(xy) z = atan2(x,y)
account which quadrant the point (X, y) is in)

Hyperbolic Sine sinh(x) y = sinh(x)
Hyperbolic Cosine cosh(x) y = cosh(x)
Hyperbolic Tangent tanh(x) y = tanh(Xx)
e o sinhCo) y=asinh(g
e e e acoshC0 y= ooty
AT st y= atan
Natural Logarithm (In(x

(where x isga positi\(/e Se;)l number) In(x) y =In(x)
Logarithm (logyx)

(where b and x are positive real numbers) log(b,x) y = log(b,x)
For OM, only log (10,x) is supported

Exponential exp(x) y = exp(X)
Absolute Value abs(x) y = abs(x)
Random number (between 0 and 1) rand() y = rand()
Modulus mod(x,y) z = mod(x,y)
Square Root sqrt(x) y = sqrt(x)
Power x pow(x,y) z = pow(X,y)
Round (rounds argument to the closest integer,

or the closest even integer for arguments | round(x) y = round(x)
equidistant from two integers)

Ceil (rounds argument to the smallest integer . .
greatér than or e%ual to the argument) ’ ceil(x) y = ceil(x)
Floor (rounds argument to the greatest integer floor(x) y = floor(x)

Min (returns the argument with minimum
value)

min(Xy,X2,X3,::1)

For Mathematica, Xy,X5,...can be arrays
or single-valued

For OM, X;,X5,...can only be single-
valued

For MATLAB SMT, use min(X) if X is
an array, or min(x1,x2,x3,...) if x1,x2,
x3,... are single-valued. Also see note®
below.

Y = min(Xy,Xz,X3)

Max (returns the argument with maximum
value)

max(Xy,X2,X3,u:.)

For Mathematica, Xy,X5,...can be arrays
or single-valued

For OM, Xy,X5,...can only be single-
valued

For MATLAB SMT, use max(X) if X is
an array or max(x1,x2,x3,...) if x1,x2,
x3,...are single-valued. Also see note'’
below.

Y = max(Xy,X2,X3)

Average (returns the arithmetic mean of

avg(x)

y = avg(X)

1 For MATLAB SMT, the inputs to min and max functions should be givens before solving. The functions do not work if their
inputs are computed by solving other equations simultaneously.
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members of the array passed as argument) where X is an array
Sum (returns the sum of the members of the | sum(x) _

. y =sum(x)
array passed as argument) where X is an array

6.6 Conditional Functions and Operators

ParaMagic® currently supports conditional statements in the following format.

<Result> = if(<Condition>, <Result if Condition = true>, <Result if Condition = false>)

For example, in the conditional statement
X2 = if(X1 > 0, X1, -X1)

X2 is set equal to X1 when X1 is positive and —=x1 when X1 is negative. Hence, this condition is the
equivalent of X2 = abs(X1).

The following operators can be used as part of the condition term

Operator Syntax Example
Equal to == y=if(x==1,2,1)
Not Equal to 1= y=if(x!=1,2,1)

Greater than > y=if(x>1,2,1)

Less than < y=if(x<1,2,1)

Greater than or Equal to >= y=if(x>=1,2,1)

Less than or Equal to <= y=if(x<=1,2,1)

AND && y=if(x1 == 0 && x2< 5,2, 1)
OR |1 y=if(xl==0]]| x2<5,2,1)
NOT ! y = if(1(x>1), 2, 1)

For MATLAB SMT, conditional expressions do not work reliably when combined with other
expressions. For e.g. a = b + if(d>e, 1, 0) will not work with MATLAB SMT. In these cases, users are
requested to use multiple simpler expressions instead, for e.g. a = b + c and c = if(d>e,1,0)

6.7 Aggregate Properties and Functions

ParaMagic® also supports aggregate value properties of type Real, that is, properties that contain a list of
one or more values of type Real.

6.7.1 Multiplicity

The default multiplicity for value properties is 1. In order to hold more than one value, the multiplicity of
the value property must be setto 1..*, 0..*, or * in the model schema.

6.7.2 Instance Slot Values

When setting up an instance for solution, values are assigned to slots for each variable—either real values
for given values or empty values as placeholders for unknowns. To add multiple values to a slot, create
the first value as normal in the Instance Specification window, then use the Plus icon at the bottom left of
the window to add additional values one at a time. Multiple empty slot values can be created in the same
way.
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6.7.3

Aggregate Functions and Operators

The following function and operators are supported by ParaMagic® for aggregate values.

Some functions are not supported or have a limited support if OpenModelica (OM) is selected as the core

solver. These functions have comments in blue.

Function Explanation
a is an aggregate of Real numbers and y is a single Real number;

y = a[2] y = second item in aggregate a;
parameterized indices not supported (a[i] not supported)

y = sum(a) a is an aggregate of Real numbers and y is a single Real number;
y=al +a2+a3 +...

y = avg(a) a is an aggregate of Real numbers and y is a single Real number;

y = mean of al, a2, a3,...

y = standarddeviation(a) a is an aggregate of Real numbers and y is a single Real number;

Not supported for OM y = standard deviation of al, a2, a3,...

y = variance(a) a is an aggregate of Real numbers and y is a single Real number;

Not supported for OM y = variance of al, a2, a3,...

. a is an aggregate of Real numbers and y is a single Real number;
y = min(a) s
y = minimum of al, a2, a3,...
_ a is an aggregate of Real numbers and y is a single Real number
y = max(a) _ :
y = maximum of al, a2, a3,...

X=a x and a are aggregates of Real numbers;

{x1, x2, x3,...} = {al, a2, a3 ...}. Note that the sizes of x and a must be same.
X, &, and b are aggregates of Real numbers;

x=a+b {x1, x2, x3...} = {al+bl, a2+b2, a3+b3 ...}; similar syntax for other math operators
and functions. Note that the sizes of x, a, and b must be same.
X and a are aggregates of Real numbers;

x = sin(a) {x1, x2, x3} = {s?n(al_), sin(a2), sin(aS_) vee}s si_milar syntax for oth_er trigonometric,
exponential, logarithmic, and hyperbolic functions. Note that the sizes of x and a
must be same.

X=n X is an aggregate of Real numbers and n is a single Real number;

Not supported for OM {x1,x2,x3...} = {n,n,n...}.

X=a+n >{< eindza age a}ggr?gf\tes onReaI ;lumbt}ars, anld nisa singf;le Rehal numliler; .

x1, x2, x3...} = {al+n, a2+n, a3+n...}; similar syntax for other math operators an

Not supported for OM functions. Note that the sizes of x and a must be same.

x = pow(n,a) x and a are aggregates of Real numbers, and n is a single Real number;

Not supported for OM {x1, x2, x3...} = {n”al,n ~a2,n” a3 ...}. Note that the sizes of x and a must be same.

For OpenModelica as the core solver, math expressions combining aggregates and single-valued variables
are not supported. For example, x = a + n, where x and a are aggregates and n is a single-valued variable
is not supported.

6.8 Complex Aggregate Relationships

ParaMagic® supports complex aggregate relationships. First, a short description of complex aggregates
and complex aggregate relationships is presented to better characterize this feature of ParaMagic®.

A primitive aggregate is a collection of primitive elements, such as real numbers, strings, integers, etc.
For example, in the relation a = avg(b), where a is a single-valued real number and b is an array of real
numbers, b is a primitive aggregate. Primitive aggregates are manifested in the SysML model when value
properties have multiplicity > 1. ParaMagic® currently supports several types of relations involving
primitive aggregates—see section 6.7 above.
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A complex aggregate is a collection of blocks (in SysML context). Complex aggregates are manifested in
a SysML model when part/reference/shared properties of a block have multiplicity > 1. For example,
Figure 7 below illustrates a car system composed of several sub-systems, including the chassis sub-
system. The Chassis is composed of several components. The parametric diagram in Figure 8 illustrates
the relationship between the mass of the Chassis block and the masses of its components.

<<block>>
Car

values
wheelMass : Real
constraints
wheelMassSum : ct _a = sum(b)
carMassSum:ct _a=b+c+d

+chassis |, +hody | +wheels (4
<<block>> <<block>> <<block>>
Chassis Body Wheel

values
assemblyCosts : Real [1..%]
cFactor : Real
constraints
massSum : ct _a = sum(b)
costCalc:ct _a=b*c

+comps [1..*

<<hlock>>
Part

Figure 7: Car example to illustrate complex aggregates

The constraint relationship embodied in the massSum constraint property is an example of a complex
aggregate relationship. This is because one of the parameters in the relationship is tied to a value property
that is owned directly/indirectly by a complex aggregate (e.g. parameter b is tied to value property mass
owned by complex aggregate comps).

par [Block] Chassis[ Chassis_Mass_Sumi ]J

mass : Real a: Real asssSum:et _a=sumi(b) |}, Real
e2

mass : Real (|

z=caonstraint>= E! comps : Part [1..%] = |

Figure 8: Parametric diagram illustrating the relationships between properties of the Chassis block (Figure 7)

In ParaMagic®, the depth of a complex aggregate relationship is defined as the maximum level of nesting
of the properties (owned by complex aggregates) constrained by that relationship. For example, the depth
of the complex aggregate relationship shown in Figure 8 above is equal to 1. The properties involved in
the relationship are mass and comps[i]l.mass. The level of nesting of mass is 0 while that of
comps[i].mass is 1. The level of nesting also corresponds to the number of complex aggregate part
boundaries crossed by the binding connector that ties the parameters of the relationship with the block
properties. For example, the connector e2 in Figure 8 crosses only 1 complex aggregate boundary (of
comps). Similarly, Figure 9 below illustrates a complex aggregate relationship (loadSum) with depth = 2.
As evident, the connector e2 crosses two complex aggregate part boundaries (floors and parkedcCars). In
Figure 9 below, if the multiplicity of floors was changed to 1, then the connector e2 would cross only 1
complex aggregate part boundary (parkedCars). Hence, the depth of the complex aggregate relationship
would change from 2 to 1.
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par [Block] ParkingDeck [ ParkingDeck ]J

floors : Floor [1..*] =

parkedCars : Car [1..*] = |}

_ [ =<constraint>> b Real
totalMassLoad : Real a: Real loadSum : ¢t _a = sumi(b) . mass : Real

el e2

Figure 9: Parametric diagram illustrating a complex aggregate relationship of depth = 2.

ParaMagic® only supports execution of complex aggregate relationships with depth = 1. In general, the
parameters of the complex aggregate relationship (and the properties they are connected to) can be single-
valued or multi-valued (e.g. array). However, properties owned by complex aggregates and the
relationship parameters they are tied to should be single-valued. For example, in the complex aggregate
relationship illustrated in Figure 8, the property comps[il.mass is owned by the complex aggregate
comps. Hence, comps[i].mass and the parameter b to which it is connected should be single-valued (as
shown) for ParaMagic® to solve this relationship. Figure 10 below illustrates a complex aggregate
relationship (costCalc) with depth = 1. ParaMagic® can solve this relationship because the property
comps[i].mass owned by the complex aggregate comps is single-valued.

par [Block] Chassis | Chass_Assembl‘g.r_Ccs*tﬂ ]J

comps : Part [1..7] |

' ==constraint== b Real mass : Real
5 |
costCalc:ct _a=b"c

a: Real fa=h*c}
[%{ cFactor : Real |

Figure 10: Parametric diagram illustrating a complex aggregate relationship with depth = 1.

assemblyCosts : Real [1.."]
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Complex aggregate relationships can also involve constraint blocks that wrap MATLAB functions/scripts
or Mathematica functions, as shown in Figure 11 below.

arAfl.m]

vp : Real -utfi : Reslf[1__*]

wconstraints
cp1 : xfwExternal_Matlab_Function

{output=xfiwwExternal{matlab, function, MyMatlabFunc,input1 )}

ULﬁput: R:eal[1..".]

wconstraints

. a: A.[1 Bl : cp1 : cMathematica_Function
: - R {output=cMathematica(Userfnd input! input2)} |-~ ot
vp1 : Real input1 : Real :‘
: : c:C M.
ot He .
b:B[1.%] . . E jp - vp3 : Real
Cnpu2cReall— B
vp2: Real :mpu 8 e :‘

Figure 11: Complex aggregate relationships involving constraint blocks that wrap MATLAB function (top) and
Mathematica function (bottom)

In some models, complex aggregate relationships involve primitive aggregates in the scope of complex
aggregates. For example the parametric diagram below shows primitive aggregate Al, in the scope of
complex aggregate input, participating in four complex aggregate relationships. In such cases, it is useful
to have aggregate functions (e.g. min, max, avg, and sum) that can operate over primitive and complex
aggregates. ParaMagic® provides this capability as shown in the table below. The model below shows
how the new functions (minca, maxca, avgca, and sumca) are used.
par [Block] Output[ Output]/J

wconstraints
CAS51: CASum
{b = sumcaia}}

b: Real[1..7]

a: Real[']..*]l:

3
B4 : Real [1.4] &

aconstraints

CAA1: CAAvg
{b = avgcala)} el
B2 : Real [1.7] e2 o . a*]: Real [1.7]|
=4 inpt : Input [1.."]
«wconstraints A1:Real [1.7]
CAN1 : CAMin
{b = mincaja)} et
]
B3 : Real [1..%] :I b Real[1.7]
a: Real[1.7] I:
ed

wconzstraints
CAX1:CAMax
{b = maxcala)}

B4 : Real [1.] 5

:| b: Real[1..%]
a:Real[1.4] |

Figure 12: Special aggregate functions (sumca, avgca, minca, maxca) for complex aggregates
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Function Explanation
y and x primitive aggregates, and input is a complex aggregate
y = sum(input.x) This is mathematically equivalent to: y[i] = Z; (input[i].x[j]), i.e. summation is

performed over the primitive aggregate x.
y and x primitive aggregates, and input is a complex aggregate

y = sumca(input.x) This is mathematically equivalent to: y[j] = Z; (input[i].x[j]1), i.e. summation is
performed over the complex aggregate input.
y and x primitive aggregates, and input is a complex aggregate

y = avg(input.x) This is mathematically equivalent to: y[i] = avg ; (input[i]l.x[j]), i.e. average is
performed over the primitive aggregate x.
y and x primitive aggregates, and input is a complex aggregate

y = avgca(input.x) This is mathematically equivalent to: y[j] = avg ; (input[i].x[j]), i.e. average is
performed over the complex aggregate input.
y and x primitive aggregates, and input is a complex aggregate

y = max(input.x) This is mathematically equivalent to: y[i] = max ; (input[i]l.x[j]), i.e. max is
performed over the primitive aggregate x.
y and x primitive aggregates, and input is a complex aggregate

y = maxca(input.x) This is mathematically equivalent to: y[j]1 = max ; (input[i].x[j]), i.e. max is
performed over the complex aggregate input.
y and x primitive aggregates, and input is a complex aggregate

y = min(input.x) This is mathematically equivalent to: y[i] = min ; (input[i].x[j]), i.e. min is
performed over the primitive aggregate x.
y and x primitive aggregates, and input is a complex aggregate

y = minca(input.x) This is mathematically equivalent to: y[j]1 = min ; (input[i]l.x[j1), i.e. min is
performed over the complex aggregate input.

6.9 Recursion and Redefinition

Recursion and redefinition are powerful concepts for modeling variant system architectures. With
ParaMagic®, users can execute SysML parametric models involving redefinition and recursion to
compute and compare measures-of-effectiveness (and/or key performance parameters) for variant
architectures.

The  VehicleMassRollup  model included in  ParaMagic® intallation  (under <MD
Root>\samples\ParaMagic\Other_Examples) is a SysML model of a vehicle system and demonstrates
how to model variant architectures using recursion and redefinition and execute the same using
ParaMagic®.

6.9.1 Recursion

Recursive Parametric Relationships are parametric constraints involving value properties of a block and
value properties of its part/reference/shared properties that are of the same type as the block itself. Figure
13 illustrates an example recursive parametric relationship. The Component block has a part property (sub
components) that is typed by the block itself—a component can have 0 or more sub components. The
Component block has a value property (mass) and a constraint property (mass rollup). As shown in the
parametric diagram in Figure 13, the mass rollup constraint relates the mass of a component with the
masses of its sub components—mass of a component is the sum of the masses of its sub-components.
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bdd [Package] Mass as Value Property [ compenent meta—mudel_lJ

ablocks

Component par [Block] Component| Recursive Summation lJ

mass : kg{unit = kilogram} cconstraints

mass rollup : Recursive Sum
{parent = sumichild}}

D"k
sub components

|—|tutall.1333 kg cumpunenﬂdﬂss':—k? [0:.%]

mass rollup - &2

sub components : Component [0..*]

wconstraints
Recursive Sum

consirsinis . .
{parent = sum(child)} mass : kg mass : kg

pErsmeiers
totalMass : kg{unit = kilogram}

componentMass : kg [0..*Kunit = kilogram}

Figure 13: SysML block definition and parametric diagrams illustrating a recursive parametric relationship

Once a recursive parametric relationship has been defined at the block level, they can be executed by
ParaMagic® in a recursive manner at the instance level. Figure 14 illustrates an instance structure
conforming to the block structure shown in Figure 13. The System (instance of Component) is composed
of 3 subsystems (instances of Component) which are then composed of other components.

bdd [Package] System Alternative 1[ System Alternative 1 - Structure View lJ
wblockn =
System : Component
mass = "{unit = kilogram}
sub components = subsystem 1, subsystem 2,
subsystem 3
| | L
wblocke ablocks ablocks
subsystem 1: Component subsystem 2 : Component subsystem 3 : Component
mass = "{unit = kilogram} mass =""{unit = kilogram} mass ="{unit = kilogram}
sub components =511, 512 sub components =s2 1,522 subcomponents =53 1,532
«blocks «blocks = «blocks «blocks
«blocks = =12 : Component e s2 2 : Component =3 1 : Component =3 2 : Component
s11: Component mass ="2.0% s2 1: Component mass ="4.07 mass ="4.07 mass ="3.0%
mass ="{unit = kilogram} unit = kilogram} mass =™ unit= kilogram} unit = kilogram} unit = kilogram}
sub components =s5111,511 i
2 ! unit = kilogram}
sub components = 52
11,5212
[ I
«blocks = «blocks «blocks «blocks
5111 : Component s112: Component 521 1: Component 521 2: Component
mass ="1.07 mass ="5.07 mass ="2.0% mass ="1.0"
unit = kilogramy} unit = kilogram} unit = kilogram} unit = kilogram}

Figure 14: Recursive parametric relationships can be executed in a recursive manner when ParaMagic® is
launched at any instance in the hierarchy.

When ParaMagic® is launched for the top-level System instance, it executes the mass rollup recursive
parametric relationship across all levels in the instance model as shown in Figure 15. The total mass of
the System computes to 22 kgs.

Similarly, when ParaMagic® is launched for the subsystem2 instance, it executes the mass rollup recursive

parametric relationship across all components in the context of subsystem2 (s2_1, s2_2, s2_1 1 and
s2_1 2), as shown in Figure 16. The total mass of subsystem2 computes to 7 kgs.
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Setup and execution of Recursive Parametric Relationships is a powerful feature of ParaMagic®
provides a simple mechanism to model recursive constraints at the block level and execute them for
system alternatives with various topologies at the instance level.

l Mame Qualified Name Causality Values
Q Companent Mass as Value Property::System Alternative ... Cnmponent
i1l mass kg target 22
E1-{1 sub components Component[0,7]
E--sub components[0] Mass as Value Property::System Alternative ... Component
EI mass ka ancillary 8 I
EHZI sub components Component[0,7] il
[-sub components[0] Mass as Value Property::System Alternative ... Component
i [ mass kg andillary [
E-LF sub components Companent[d,7]
El-sub companents[0] Mass as Value Property::System Alternative ... Component
H LT mass kg given 1
B sub companents[1] Mass as Value Property::System Alternative ... Component
H 1] mass kg given 5
E sub components[1] Mass as Value Property::System Alternative ... Component
U] mass L] given 2
[=-sub compaonents[1] Mass as Value Property::System Alternative ... Component
[T mass ka anillary 7
B EI sub components Component[0,7]
E sub companents[0] Mass as Value Property::System Alternative ... Component
P W mass kg andilary 3
E| -[F] sub components Compenent[d,7]
Elsub components[0] Mass a5 Value Property::System Alternative ... Component
LT mass kg given 2
sub components[1] Mass 3z Value Property::System Alternative ... Component
H 1] mass kg given 1
E sub components[1] Mass as Value Property::System Alternative ... Component
{1 mass ka given 4
[E-sub components[2] Mass as Value Property::System Alternative ... Component
[T mass ka anillary 7
B Ijl sub components Component[,7]
E sub companents[0] Mass as Value Property::System Alternative ... Component
i [ mass kg given 4
E--sub companents[1] Mass as Value Property::System Alternative ... Component
LT mass kg given 3
An:ut ( Component )
Name Local Redefined Relation Active
mass rollup ‘Y ‘ |mass=sum{sub components.mass) |

Figure 15: Executing recursive parametric relationship (mass rollup) for the System instance

Qualified Name Causality Values

Mass as Value Property::... Component
"
E-[F sub components Companent[d,?]
E} sub components[0] Mass as Value Property::... Component
i andillary
Component[0,7]
Mass a5 Value Property::... Component

Mass as Value Property::... Component

Mass a5 Value Property::... Component
kg

[ Expand ][ Collapse all ] Solve DPreserueRer

root { Component )

Name Local Rede... Relation

mass rollup |Y | |mass=sum(sub components.mass)

Figure 16: Executing recursive parametric relationship (mass rollup) for the subsystem 2 instance
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6.9.2 Redefinition

When building models of complex systems, generic concepts are successively specialized into several
concrete concepts using inheritance. It is then required that these concrete concepts redefine properties
and constraints inherited from generic concepts. Redefinition in SysML is the mechanism to achieve this.
ParaMagic® provides the ability to detect and execute parametric relationships involving block
properties—such as value, part, reference, shared, or constraint—that have been redefined, either
implicitly or explicitly.

In explicit redefinition, the owned properties of a block redefine inherited properties by referencing them
in the SysML model—populating the redefined property field in the specification for an owned property.
The owned property and the inherited property can have different names. See section 6.9.2.1 for details.

In implicit redefinition, the owned property of a block redefines an inherited property by having the same
name as the inherited property. See section 6.9.2.2 for details.

6.9.2.1 Explicit Redefinition
Explicit redefinition is the recommended approach for redefining inherited properties in SysML. The
model shown in Figure 17 (BDD) illustrates explicit redefinition.

bdd [Package] Parts Explictly Redefined | ExplictRedsfintionBDD |) Block A has the followi ng
ablocks roperties: b (part property), ¢
B
woonarars 7 = (reference property), d (shared
e e e property), n (contraint property),
Z=w+x+y} £ velues and v (value property). The
x;"gi;j”’e‘” al parametric model for block A (top
y:Rea . -
= o Jalues left in Figure 18) shows how the
value properties owned by block A
= and its  part/reference/shared
ALIEE b1 | values properties are constrained (A.v =
wconstraints Achild {redefines b} el ablocks b b d d
. ~vates — e Vb + c.ve + d.vd).
consiraints n i values
Z=x+y-w} {redefines c} |ve! - Real ablocks A .
oaanets {redefines|n} | 1 ?1 Block Achild is a_subtype of block
) R {redefines d} 7 Rea A and hence inherits all the
w‘:lfeﬂa\ i
properties of block A. However,
Achild has its own part, reference,
«blocke -
_ ks b2 | B2 shared, constraint, and value
cB2 parneenid {redefines b} | /25 properties that explicitly redefine
constraints nz2 v2 : Real . . .
N e L the _correspondm_g m_herlted
parameters o oz properties. To achieve this, the
e {redefines a1 | (3lk=s Redefined Property field for each
o of the owned properties of Achild

(b1, c1, di, n1, and vl1) was
populated with the corresponding
inherited property (b, c, d, n, and v
respectively), as shown in Figure 19. As a result, the owned properties show the “redefine” keyword in
Figure 17. The parametric model for Achild in Figure 18 (see top-right) shows how the value properties
owned by block Achild and its part/reference/shared properties are constrained (Achild.vl = cl.vcl +
dl.vdl — bl.vbl). Note how the constraint specification in the redefined constraint property (nl) is
different compared to the constraint specification in the inherited constraint property (n).

Figure 17: Explicit redefinition of inherited value, part, reference,
shared, and constraint properties
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Similarly, the owned properties of block Agrandchild redefine the inherited properties b1, d1, nl1. The
inherited property cl is not redefined and hence used by Agrandchild. The parametric model for
Agrandchild in Figure 18 (bottom) shows how the properties of Agrandchild (redefined and inherited) are
constrained (Agrandchild.v2 = b2.vb2 * cl.vcl * d2.vd2). Note how the constraint specification in the
redefined constraint property (n2) is different compared to the constraint specification in the inherited
constraint property (n1).

par [Block] A[ A_Explicit ]

aconstraints

n:CB

ell w : Real

T

{z=w+x+y}

]

el

T REAm

el12 y : Real

es z:Real

]

par [Block] Achild [ Achild_EpricitlJ

b1 : B4

el w : Real

vb1 : Real

ed x: Real

&3 v Real

g2 z: Real

«constraints
n1: CB1
{z=x+y-w}

par [Block] Agrandchild [ Agrandchild_ExplicﬂlJ

b2 : 82

el

vb2 : Real

e e |

w . Heal

e7

* . Real

v . Real

v2 : Real

z : Real

]

wconstraints
n2:CB2
fz=w*x*y}

Figure 18: Parametric models for blocks A, Achild, and Agrandchild illustrating constraint relationships involving
owned properties that explicitly redefine inherited properties
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Specification of Constraint Property properties

Specify properties of the selected Constraint Property in the properties specification table. Choose the Expert or All options from the Properties drop-down list to

see more properties,

BBz « =

\Usage in Diagrams

Qualifiers

| DocumentationHyperlinks
Inner Elements

Relations

Tags

Constraints

Traceability

Language Properties

m:) -+11 : Constraints Explicitly Redefinec rnl

History :’ [ n1: CB1 [Constraints Explictly Redefined::Parts Explidtly Redefined::A... =

gl o =] = oet

Properties:[ﬂ

+ [ customize

Qualifier
Association
Subsetted Property
Opposite

Datatype

Owning Association

tedefined Property

Redefined Property
References the properties that are redefined by this property.

| Q- Type here to filter properties

Back

Figure 19: Explicitly redefining properties in MagicDraw
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bdd [Package] Inztances | E:-cplic'rtlnstann:eslj

Correct

wv=3

expected value:

ablocks E

Al A

| —

v=2

expected value:

v="13

expected value:

b =B01
c=CcM
d=0D01

ablocks
B01:8

v ="1.07

="

ablocks
CM:C

vo="1.0"

wblocks
D010

vd ="1.0°

xblocks
AD2 : Achild

b1=B02
c1=0C02
d1=D02
Ly ="

ablocks
B02:B1

vl =2.0

ablocks
Cco2:C1

vl =20

ablocks
Do2: D1

vd1=2.0

xblocks
A3 » Agrandchild

b2 = BO3
c1=C03
d2 = D03
v2="

ablocks
B3 : B2

vb2 =3.0

ablocks
Co3:C1

vl =20

ablocks
D3 : D2

vdZ2 = 3.0

Copyright © 2014 InterCAX LLC. All Rights Reserved.

Figure 20: Instance model in ready-to-solve state

35



ParaMagic® 18.0 e Users Guide

Qualified Name
Constraints Explicitly Rede...

Constraints Explicitly Rede...

Constraints Explicitly Rede...

Constraints Explicitly Rede...

Collapse Al Solve [ Preserve Refs | Update to SysML

Ar;ot (a)

Name Local Rede... Relation
|v=b.vb+c.vc+d.vd

Figure 21: Solved instance A01

N ParaMagic(R) 17.0.2 - [

Qualified Name Causality Values
Constraints Explicitly Redefine...

target
Constraints Explicitly Redefine...

given

Constraints Explicitly Redefine...
given
Constraints Explicitly Redefine...

Collapse Al Salve || Preserve Refs | Update to SysML

oot [ Achid)

Name Local Rede... Relation
vi=clvci+dlvdi-blvbl

Qualified Name Type Causality  Values

Constraints Explicitly Redefin... Agrandchild
Real target
Constraints Explicitly Redefin... B2
Real given
Constraints Explicitly Redefin...
given
Constraints Explicitly Redefin...
given

Solve [7] Preserve Refs | Update to SysML

root { Agrandchild )

Name Local Rede... Relation
n2 ¥ |1 [v2=b2.vb2*c1.vc1*d2.vd2

Figure 23: Solved instance AO3

Figure 20 shows instances A0l (of
block A), A02 (of block Achild), and
AO03 (of block Agrandchild) in a ready-
to-solve state. The ParaMagic® browser
shows the same instances in a solved
state in Figure 21, Figure 22, and Figure
23 respectively. Note that the

ParaMagic®  browser shows the
redefined constraint properties for
instances A02 and A03—see the

equation section (lower part) in the
browser in Figure 22 and Figure 23. The
target slots (AOl.v, A02.vl1, and
A03.v2) in the ParaMagic® browsers
show the result of executing the
parametric models for instances AO01,
A02, and A03 respectively.
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6.9.2.2 Implicit Redefinition

Implicit redefinition is an alternative approach to redefining (overriding) inherited properties. The model
shown in Figure 24 (BDD) illustrates implicit redefinition.

bdd [Package] Parts Implicitly Redefined | Implic'rtRedefinitiunBDDlJ

«blocks
wconstraints A

cB b

«blocks

values
constraints v : Real
fZ=w+x+y}

values
vb : Real

wblocks

c

parameters
x : Real
v : Real
z :Real

values
vc : Real

wblocks

D

w : Real

ablocks b

«blocks

B1

«constraints Achild

CcB1 values
v : Real

constraints

values
vb : Real

values
vd : Real

wblocks

c1

values
vc: Real

{Z=x+y-w}

parameters

wblocks

D1

X :Real
¥ : Real
z :Real
w : Real

«constraints Agrandchild

wblocks b

wblocks

B2

ce2 values

constraints n v : Real
{Z=w*x*y}

parameters
x: Real

values
vb : Real

values
vd : Real

wblocks

D2

v : Real
Z : Real
w : Real

values
vd : Real

Figure 24: Implicit redefinition of inherited value, part, reference, shared, and

constraint properties

This model is similar to the
model shown in Figure 17
and described in the
previous section except that
Achild and Agrandchild
have part, reference, shared,
constraint, and value
properties that override the
inherited  properties by
having the same names. For
example, Achild has an
owned part property b that
overrides the inherited part
property (A.b) because it
has the same name. The
same pattern is used by
Agrandchild for redefining
properties inherited from
Achild.

Though this method of
using a name conflict to
redefine inherited properties
is easy to use since it does
not  require  explicitly
referencing the inherited
property (as shown in

Figure 19), it is ambiguous and not recommended due to poor model readability. However, ParaMagic®
can treat name conflicts between owned and inherited properties as a form of redefinition and can execute
models the same way as shown for explicit redefinition in the previous section.

Figure 25 illustrates the parameteric models for blocks A, Achild, and Agrandchild. The parametric
models are setup in the same manner as those in Figure 18. The parametric models for blocks A and
Achild have constraint relationships between their owned properties. The owned properties of block
Achild implicitly redefine the properties inherited from block A because they have the same names. The
parametric model for the block Agrandchild has a constraint relationship (n) between its owned properties
(Agrandchild.b, Agrandchild.d, and Agrandchild.n) and an inherited property (Achild.c).
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par [Block] A[ A_Implicit
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Figure 25: Parametric models for blocks A, Achild, and Agrandchild illustrating constraint relationships involving
owned properties that implicitly redefine inherited properties
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| Qualified Mame Causality Values
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target
Constraints Implicity Redefined::Parts I...

given

Constraints Implicitly Redefined::Parts L.

given
Constraints Implicitly Redefined::Parts I...
agiven

Collapse Al Solve || Preserve Refs | Update to SysML

Ar;ot (A)

Name Local Rede... Relation
n ‘\" | |v =b.vb+c.ve+d.vd

Figure 27: Solved instance A01

' ParaMagic(R) 17.0.2 - AQ2 (o o=
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o Real target 2|
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Collapze Al Salve [ Preserve Refs | Update to SysML
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Figure 28: Solved instance A02

N ParaMagic(R) 17.02 - A03 [E=NEEN

Qualified Name Causality Values

Constraints Implicitly Redefined: :Parts Im... Agrandd’1lld

Real target
Constraints Implicitly Redefined: :Parts Im... B2

Real given
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given
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given

[ Expand ][ Collapse All ] Solve DPreserve Refs

Ar;ot { Agrandchild }
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n |Y | |\-' =b.vb¥c.vc™d.vd

Figure 29: Solved instance AO3

Figure 26 shows instances AO1 (of blocs
A), A02 (of block Achild), and A03 (of
block Agrandchild) in a ready-to-solve
state. The ParaMagic® browser shows
the same instances in a solved state in
Figure 27, Figure 28, and Figure 29
respectively. Note that the ParaMagic®
browser shows the redefined constraint
properties for instances A02 and AQ03 in
the equation section (bottom part) of
Figure 28 and Figure 29 respectively.
The target slots (AOl.v, AO2.v, and
A03.v) in the three ParaMagic®
browsers show the result of executing
the parametric models for instances
A01, A02, and AO03.
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6.10 Limitations

ParaMagic® 18.0 has the following limitations with respect to SysML models. Several of these are
limitations of the core solvers.

1)

2)

3)

4)

5)

OpenModelica (OM) as the core solver — If OM is selected as the core solver, the following

limitations exist:

a) For OM, the number of parametric relations should be equal to the number of unknown variables
(value properties).

b) Some math functions are not supported or have a limited support if OM is selected as the core
solver. These functions are commented in blue in sections 6.5, 6.6, and 0.

¢) ParaMagic — Custom Mathematica Connection (section 8.1) is not supported

d) ParaMagic — MATLAB Connection (section 8.3) is not supported

MATLAB Symbolic Math Toolbox (SMT) as the core solver — If MATLAB SMT is selected as the

core solver, the following limitations exist:

a) For SMT, the number of parametric relations should be equal to the number of unknown variables
(value properties).

b) Some math functions have a limited support as commented in red in sections 6.5-6.7.

c) Conditional expressions do not work reliably when combined with other expressions. For e.g. a =
b + if(d>e, 1, 0) will not work with MATLAB SMT. In these cases, users are requested to use
multiple simpler expressions instead, for e.g. a = b + c and c = if(d>e,1,0)

d) Inputs to min and max functions should be givens before solving. The functions do not work if
their inputs are computed by solving other equations simultaneously.

e) ParaMagic — Custom Mathematica Connection (section 8.1) is not supported

Constraint block-related limitations - This version of ParaMagic® does not support:
a) multiple constraint specifications in a constraint block.

b) constraint blocks composed of other constraint blocks.

c) inequality constraints.

Binding connectors between constraint parameters — This version of ParaMagic® supports binding
connectors between constraint parameters only when the multiplicity on constraint parameters is
unspecified (1) or set to 1. If the multiplicity of one (or both) constraint parameter(s) at the ends of a
binding connector is greater than 1, ParaMagic® shows the following validation error and lists the
specific binding connectors. As a workaround, users can create an intermediate value property and
connect the constraint parameters to that intermediate value property.

The following constraint parameters used are connected by a binding connector, but one (or both) of them
have multiplicity > 1. Currently, only binding connectors between constraint parameters with multiplicity 1 (or
unspecified) are supported. As a workaround, create an intermediate value property with multiplicity > 1 and
create binding connectors to that value property from both the constraint parameters. See the User Guide for
further details.

- Block "Many_Links::Domain2"

"add1.c" and "subl.a"

"subl.c" and "multl.a"

"divi.a" and "multl.c"

Cyclic references-related limitations - This version of ParaMagic® does not support some types of
cyclic references among model instance elements. Specifically, the following scenarios are not
supported:
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a) A block instance has a slot that it is populated with the instance itself, i.e. the instance points to
itself.

b) Given two block instances, each has a slot that is populated with the other instance. For e.g.
instance A points to instance B, and instance B points to instance A.

Note that a block may have a property typed by the block itself. This looping structure at the block
level is supported if there is no looping at the instance level.

6) Value Types, Value Specification, and Causality

a) See section 6.4 for requirements on value properties that can participate in parametric relations.

b) ParaMagic® treats all numbers as real numbers.

c) Values populating instance slots must be one of the following types: LiteralString, LiteralReal, or
Literallnteger.

d) Slots corresponding to value properties that are typed by Integer (or its subtype) should have
causality “given”, i.e. they can only be inputs to parametric calculations. ParaMagic® treats
integers (only allowed as inputs) as real numbers during solving.

e) ParaMagic® does not perform automated unit conversions in math expressions. Thus, instance
validation and solution do not check for the consistency of units. Users must provide instance
values with consistent units.

7) If the value property corresponding to a slot is connected to the outputs of multiple ONEWAY
relations, then the slot must have causality “given”. This restriction is imposed to prevent instance
models from being over-constrained—conflicting values of such slots may be computed from the
different ONEWAY relations.

8) Complex numbers — This version of ParaMagic® does not support complex numbers. If solution
results return a complex number for a variable, a string No Value is displayed for that variable in the
ParaMagic® browser.

9) Complex Aggregate Relationships — Complex aggregate relationships with depth > 1 are not
supported in this version of ParaMagic®. See section 6.8 for details.

10) This version of ParaMagic® does not support scientific notation for numbers.

11) If you change the causality of a solved target variable to given in MagicDraw and launch the
ParaMagic® browser, you may see an over-constrained set of values. ParaMagic® does not check for
over-constrained instance values during validation. To resolve such states, users should identify a new
target variable and re-solve the model.

12) When you successfully validate the schema structure of a model (see validate in section 7.1), you
will receive the message in Figure 30.
a) The warning is to inform you that this validation function effectively checks the syntax and
connectivity of the structure of your SysML model schema as far as parametrics solving goes.
b) At this stage ParaMagic® does not check for over-constrained equations and similar non-syntactic
issues. In general the math solver that you can later invoke via the ParaMagic® Browser will
uncover such issues (usually by returning a “No Value” result or an over-constraint warning.

13) When you successfully validate the instance structure of a model (see Validate in section 7.1), you
will receive the message in Figure 31.
a) The warning is to inform you that this validation function effectively checks the syntax and
connectivity of the structure of your SysML model instance as far as parametrics solving goes.
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b) ParaMagic® does not check for over-constrained values or inconsistent causalities and similar
non-syntactic issues at the instance validation stage. Such issues will be uncovered during the
instance solution stage, usually by returning a No Value result (in the ParaMagic® browser) or an
over-constraint warning.

¥ ParaMagic M ParaMagic
J::) SysML block structure is valid. y SysML instance structure is valid.
Note that schema validation does not check for equation Note that instance structure validation does not check for incompatible values,
over-constraints, etc. See the Limitations section in Users Guide. causalities, units, etc. See the Limitations section in Users Guide.

Figure 30: Structure validation notice Figure 31: Instance validation notice

14) When you open an existing instance from MagicDraw for browsing (see Browse in section 7.1) you
will see the warning message in Figure 32 if that instance has values for any attribute with causality
“target” or “ancillary”.

a) This situation exists because you have stored previously solved values in the SysML model.
Usually it is not a problem and you can browse the instance to review its results without concern
(if you fully control the model and know its change history), but in general we recommend re-
setting the instance and re-solving it to be safe.

b) There are several ways that previously solved instance values can become invalid (because the
instance in MagicDraw is not continuously connected to the instance in the ParaMagic® browser),
including:

i) Someone changed the corresponding schema structure in MagicDraw after that instance was
solved (e.g., they added a new equation or changed an existing equation).

i) Someone changed an attribute value or an attribute causality in the instance in MagicDraw.
In general we recommend not making such changes in MagicDraw for a previously solved
instance. Instead, open the ParaMagic® browser and then make such changes.

In other words, for example if you make structural changes to your SysML model schema, such
as redrawing the connectors in a parametric diagram, you can still browse the old solved instance
(conforming to the schema before changes) in ParaMagic®. With the changes in the model, the
values in old instances may be non-conformant to the model schema. This version of ParaMagic®
does not automatically re-solve (update) old instances to conform with the new schema. It is
recommended that after structural changes to the model schema, users should (a) re-validate the
schema, (b) open the ParaMagic® browser, (c) Reset all non-given values (automatically by
pressing the Reset button), and (d) solve the instance again.

This instance has values populated For one ar mare properties with a
. target ar ancillary causality. You may or may not need ko reset these values
and re-solve to ensure consistency. See explanation in Users Guide Limitations.

Figure 32: Warning regarding previously solved instance values.

15) Mathematica solving issues:
a) If a system of equations is under-constrained, ParaMagic® browser shows that no value is
available for one or more target variables after solving. It does not explicitly warn the user that
the system of equations was under-constrained.
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b)

In some cases, while solving a large system of equations in the reverse direction (non-natural
direction), Mathematica returns an over-constrained set of values (without exceptions or
warnings). Contact us (support@intercax.com) for further information.

16) ParaMagic®-MATLAB Connection: When constraint blocks (properties) wrapping MATLAB
functions/scripts are connected with value properties that have multiplicity > 1, then the size of array
returned by MATLAB must match the size of array initialized in the SysML instance model.
Specifically,

a)

b)

c)

If the size of array returned from MATLAB > size of array in the SysML instance model, then
ParaMagic® throws an error message as below.

The number of results ("50") obtained from the external model do not match with the number
of allowable values ™1 in the expression
"outs=xfwExternal(matlab,function,matlab_fmpmo,ins1)" in "Bugs::Output
Mismatch::Instance0O1::Instance01".

If the size of array returned from MATLAB < size of array in the SysML instance model, then
ParaMagic® solves the model but shows the following warning

WARN The number of results ("50") obtained from the external model do not match with the
number of allowable values ("51") in the expression
"outs=xfwExternal(matlab,function,matlab_fmpmo,ins1)" in "Bugs::Output
Mismatch::Instance02::Instance02". The first "50" values are used as the result.

If the size of array returned from MATLAB = size of array in the SysML instance model, then
ParaMagic® solves the model.

17) Plotting: The plotting functions available with ParaMagic® use the ParaMagic-Custom Mathematica
connection (section 8.1.3). This requires that users select Mathematica or PlayerPro as their core
solver. During parametric model execution, users may be prompted to select a Math link program.

a)

b)

c)

v

For Windows, if asked to select a Mathlink program, select WolframPlayerPro.exe in the
PlayerPro installation (if using PlayerPro), or select Mathematica.exe in the Mathematica
installation (if using Mathematica).

For Mac, users will NOT be asked to select a Mathlink program. Plots will be created if
Mathematica or PlayerPro is selected as the core solver.

For Linux, users will NOT be asked to select a Mathlink program. Plots will be only created if
the symbolic link /usr/local/bin/math iS pointing to Mathematica math kernel
/usr/local/Wolfram/Mathematica/9.0/Executables/math

PROGRAM FEATURES

7.1 Command Menus

ParaMagic® commands are applied by right-mouse-clicking on the appropriate block or package in the
MagicDraw containment tree and selecting the menu item ParaMagic.

Command Description
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Validate'®

Browse

util >
Assign default causalities

util >
Set default instance

Util > Convert Connector to

Binding Connector

Util > Silent > Solve

Util > Silent > Solve and
Update

Excel > Setup

Excel > Read from Excel

Excel > Write to Excel

When applied to a block, it validates the block structure. Block structure
refers to the block itself and all its properties recursively (e.g. parts of
parts).

e When applied to an instance, it validates the instance structure and
launches the ParaMagic® browser for that instance structure. Here
instance structure refers to the instance itself and all its slots
recursively.

e When applied to a package for which a default instance has been set,
it validates the default instance and launches the ParaMagic® browser
(same as above).

e When applied to an instance, it assigns default causality to each
variable (slot) in the instance structure. Here instance structure refers
to the instance itself and all its slots recursively. Variables that have
value(s) are assigned causality given, and variables without value(s)
are assigned causality undefined. At least one variable must be
assigned manually as target to solve the model.

e When applied to a package, it assigns default causality to all instances
(and their related instances) in the package.

When applied to an instance, it assigns that instance as the default
instance for the package owning that instance. Once assigned, users can
browse the instance (launch the ParaMagic® browser) from the package.
When applied to a connector (listed in Relations under a SysML Block), it
converts the connector to a binding connector. When using MagicDraw, it
is possible for users to accidently create connectors instead of binding
connectors on a parametric diagram. ParaMagic® only reads binding
connectors in a parametric model as per the SysML specification. This
utility helps users to upgrade a connector to a binding connector.

When applied to an instance, it solves the parametric model in the context

of that instance, and writes out the results to the ParaMagic® Silent Target

log file (see section 7.4) without launching the ParaMagic® browser. This
action is the same as launching the ParaMagic® browser (Browse
command) on an instance and then pressing the Solve button.

When applied to an instance, it has the same behavior as Util > Silent >

Solve command (above) plus it also updates the SysML instance model

with the solved results. This action is the same as launching the

ParaMagic® browser (Browse command) on an instance, pressing the

Solve button, and then pressing the Update to SysML button after solving

completes.

When applied to an instance, it launches the Excel setup utility to connect

instances to Excel spreadsheets. This connection is used to read/write

values from/to spreadsheets to/from SysML instance models. See section

8.2.2 for details.

When launched on a slot/instance/package, it reads values from

connected Excel spreadsheet(s) into the instance slots. See the table at the

end of Step 6 in section 8.2.2.1.

When launched on a slot/instance/package, it writes values from instance

8 Note that ParaMagic® validation may not include validation errors / warnings in the SysML model that are shown by
MagicDraw. It is recommended that users resolve validation errors shown by MagicDraw before using ParaMagic®
capabilities. ParaMagic® further validates the block structure, instance structure, and parametric model to ensure that it is

solvable.
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Excel > Create Instances
from Excel

Trade Study > Setup

Trade Study > Run

Help > Users Guide

Help > Tutorials

7.2 Browser

slots to the connected Excel spreadsheets. See the table at the end of Step

6 in section 8.2.2.1.

When applied to a block, it launches ParaMagic® instance generation

utility which is used to generate instances of the block based on tabulated

data in Excel spreadsheet(s). See section 8.2.1 for details.

e When applied to an instance, it launches the trade study setup utility.

e When applied to a package for which a default instance has been set, it
launches the trade study setup utility for the default instance.

e When applied to an instance, it runs the trade study

e When applied to a package for which a default instance has been set, it
runs the trade study for that default instance.

When applied to any model element, it launches the ParaMagic® User

Guide, located at <MD_Root>\manual\ParaMagic Plugin UserGuide.pdf.

The User Guide is also accessible via MagicDraw Help > Other

Documentation > ParaMagic Plugin UserGuide

When applied to any model element, it launches the ParaMagic® tutorials

folder, located at <MD_Root>\samples\ParaMagic\Tutorials

The ParaMagic® plugin browser displays the parametric model variables and controls for solving and
displaying the variable values. An example of the browser window is shown in Figure 33 below. The
ParaMagic® browser displays properties in the following order—value, part, shared, and reference.

The ParaMagic® browser only displays slots whose corresponding value properties are typed by Real,
Integer, String, or a value type representing a quantity, and their subtypes. For more details, refer to

section 6.4.
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R T )

Variable Browser

e . guallﬁed Mame Type Caus... Values (ShOWﬂ in expanded
thﬂeEye: Instancel2::covera,.. CoverageAna...
{1 milesScannedPerHour Real given 40 form)
i1 number AvailableSystems Real undefi... m
ljl numberMilesScannedPer 24Hours Real target Errkrd
=N litdeEyeSystem LiteEye::Instance02::covera... LitHeEyeSystem
E-CH litleEyeAircraft LitleEye::Instance02: :covera... LitteEyeaircraft
-] dutyCycle_CameraRefit Real given 0.03
- 1] dutyCyde_Maintenance Real given 0.02
{0 dutyCycle_Plane Real undefi... 7997
-] dutyCycle_Turnaround Real given 0.23
[ 1] numberAvailablePlanes Real undefi... m
-] numberAvailablePlanesByDay Real undefi... ErEEr
- [1] numberAvailablePlanesByMight Real undefi... e
-] numberDayCameras Real given 3
1] numberMightCameras Real given 7
-—{ W] numberPlanes Real given 4
EHCF littleEyeCrew LitleEye::Instance02: :covera... LitteEyeCrew
-] ncrewTimeOon Real given 0.42|
- 1] numberAvailableCrews Real undefi... m
-] numberCrews Real given 5
EH-CF litteEyeFuel LiteEye::Instance02::covera... LitdeEyeFuel
-1 dailyFuelLoadPerPlane Real given 50
-] fuelSupplyPerDay Real given 250
-] numberAvailableFuelLoads Real undefi... Errkrd

’ Expand ][ Collapse Al ] Reset PreserveRefs Toolbar

root ( CoverageAnalysis )

Name Local Redef... Relation Active Re'ationship Browser
sae Y numberAvailableSystems =min{itteEyeSystem. litteEyeAircraft.numbera. ..
se u numberMilesscannedPer 24Hours =number AvailableSystems *milesScanne. ..

Figure 33: Browser window

7.2.1 "Solution in progress” Window

When the Solve button on the browser is clicked, a network of parametric equations is constructed and
solved using Mathematica / PlayerPro / OpenModelica / MATLAB SMT. ParaMagic® waits for the
results to be returned. During this interval, a Solution in progress window is displayed, as shown in
Figure 34below.

-
& Solution in pmgﬁsL EH-Q

Trying to solve using Mathematica [ Player Pro via local machine. ..

Figure 34: Solution in progress window when using Mathematica / PlayerPro

The Cancel button causes ParaMagic® to ignore any intermediate results returned from the solvers, to
reset the model values (same as pushing Reset), and to return to the ready-to-solve condition. It does not
necessarily affect the solver directly (i.e., the solver job may continue to execute, in which case
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ParaMagic® will ignore any results it obtains). If the solver job itself hangs, it may require manual
intervention before you can continue solving models via ParaMagic®.

7.2.2 Variable Browser

Each variable is shown with Name, Type, Causality and Value. Variable causality can be changed in the
browser window by clicking on the causality type and selecting from the list. Four possibilities are
available for Causality. A user can only specify causality to be Given, Undefined, or Target. If a variable
with initial causality Undefined is used to compute other variables with during solution, its causality will
automatically change to Ancillary after solving.

Command Description

Given Value is assigned before solving

Undefined Value may be calculated during solving if it is needed to determine a Target, directly or
indirectly.

Target Value is calculated during solving (if Mathematica can find a valid solution). At least
one unknown must be assigned as a target variable to initiate the solution process.

Ancillary A variable whose value is calculated during solving and used to calculate the value of

another variable. The value of this variable is not available before solving.

The value of a Given variable can be changed by clicking on its value and editing it. All other variables
must be changed to Given before they can be edited (see 7.2.5 for more about this).

The size of the Variable Browser window may be expanded by 1) dragging down the lower border of the

Browser window, followed by 2) dragging down the horizontal black line between the Toolbar and
Relationship Browser.

7.2.3 Toolbar

Command Description

Expand Expands all blocks in the variable browser one tree level per button click

Collapse All Fully collapses the tree structure of the variable browser

Reset Resets the values of all target and ancillary variables in a solved instance, and
changes the causality of ancillary variables to undefined

Solve Exports the model to Mathematica for execution and displays the results in the
Browser window after solving is complete

Update to SysML Causes the results in the Browser window to be exported to the SysML instance
in MagicDraw

7.2.4 Relationship Browser

The Relationship Browser displays the constraint equations present in the parametric model and shows
their current status during solution. By selecting one of the blocks in the Variable Browser (e.g.
LittleAircraft in Figure 33), the equations specific to that part of the model are displayed in the
Relationship Browser.

The checkbox in the Active column allows individual equations to be “turned off”” during solving, i.e. not
exported to Mathematica. This may prevent other parts of the parametric model from being solved.

The columns Local and Oneway refer to local vs. inherited characteristics and static causality
characteristics of the equations. These are not user-controlled via this browser—they are determined by
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the structure of the model, which the user can change in MagicDraw and then re-open in the ParaMagic®

browser to see the updated Local or Oneway properties.

7.2.5 Editing an Instance in the Browser Window

Attribute values and attribute causalities can be modified within the Browser window, as well as in the
SysML instance diagram before launching the browser. Note that editing the SysML instance after the
Browser is launched will not update the Browser. Changing either a value or causality in the Browser
after a solution has been calculated will return the model to an unsolved state, which can then be solved
with the changed parameters.

In ParaMagic®, users can select the max number of decimal places to display in the browser. This can be
done by specifying the value of maxNumberOfDecimalsToDisplay variable in the ParaMagic.ini file. See
section 7.3 below for details. When a user points the mouse cursor over the displayed value, the browser
will indicate the true value of the variable. If a user double-clicks on value with causality= “given”, the
true value will be displayed in the edit box.

) ParaMagic(R) 18.0 - coverageAnalysis T, | )

MName Qualified Name Type Caus... Values
LitﬂeEye::InstanceDZ::covera... CoverageAnal... s
1] milesScannedPerHour Real given 40
[ numberAvailableSystems Real ancillary 2.1
1] numberMilesscannedPer 24Hours Real target 2,016
=R | litleEyeSystem LitteEye::Instance02::covera... LitHeEyeSystem |
=R litteEyeAircraft LitteEye::Instance02::covera... LitHeEyeAircraft 3 I
-] dutyCycle_CameraRefit Real given 0.09
- 1] dutyCycle_Maintenance Real given 0.02 I
- 1] dutyCyde_Plane Real ancillary 0.687
1] dutyCycle_Turnaround Real given 0.23
-] number AvailableFlanes Real ancillary 2.403
1] numberAvailablePlanesByDay Real ancillary
-] number AvailablePlanesByNight Real ancillary
1] numberDayCameras Real given 3
[ 1] numberMightCameras Real given 7~

Figure 35: Hover the mouse pointer over the displayed value to see the true value.

7.3 ParaMagic® Settings

The ParaMagic® Settings menu provides the capability to set variables that control ParaMagic® behavior.
The ParaMagic® Settings menu can be launched from MagicDraw by selecting Options > Environment,
and then selecting ParaMagic Settings, as shown in Figure 36 below.
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| ParaMagic Settings options
Change various ParaMagic Settings options and configurations.
1
|
E E?"'EFE' ParaMagic Settings
----- iagram
----- % Browser 'E 8 E‘ B EFX
""" EL?D Composition Inspection El Core solver and other settings -
----- % Colabaraton s T A S atrenaica P o =
""" S8 CVS Working Directory Mathematica / Flayer Pro
""" & Undate Solver Timeout (OpenModelica
g E::g::: ’ MATLAB M-File Default Location MATLAB_SMT
. Browser Display Predsion -1
----- < Plugins
..... @ Resources Show Stats [] false
_____ PY Path Variables Mathematica [ Player Pro Kernel C:\Program Files\Wolfram Research\Wolfram ... |E
w speling Log Message Level WARNING
..... [ Launchers : Bl Local vs. Remote core solver
..... E Experience i UseLocal Solver true
----- [B] External Tools i Remote Solver - Host URL xws. magicdraw, com: 3030
----- [=] Motifications Remote Solver - Access Key temphccesskey
""" @ Code Engineering Remote Solver - Retry Limit 1 n
""" Document Modeling Remote Solver - Time between Retries 1000
""" <==2' Edlipse UML2 (v1.3) XML El Mac and Linux-specific settings =
----- T Edipse UML2 {v2.x) XMI - - — —
----- = Edlipse UML2 {v3.3) XMI Core Solver
..... +. Edlipse UML2 (v4.x) XMI Solver used by ParaMagic for executing parametric relationships, except externally-defined
_____ £ Enterprise Architect Import functions. Select Mathematica / Player Pro, OpenModelica, or MATLAE SMT as the core solver,
- "ff Macros
=P] Q- Type here to filter properties
|2 Report Wizard
----- & s
[ QK ] [ Cancel ] [ Help ]

Figure 36: ParaMagic™ Settings Menu
If you select a variable you will see a short description of that variable, as shown in Figure 36 above. The
function of each setting/variable is described below.

Core solver and other settings

1. Core Solver — This variable is used to select the core solver. Options are Mathematica / PlayerPro,
OpenModelica, or MATLAB Symbolic Math Toolbox (SMT).

2. Working Directory — This variable is used to specify the working directory for ParaMagic®. This
directory is used by ParaMagic® to save temporary files during the solving process. If the field is
empty, ParaMagic® uses the default location which is a temp folder insider the ParaMagic® Working
Folder (see section 7.4), such as the following on Windows 7.
<Your user dir>\AppData\Local\.magicdraw\18.0\plugins\com.intercax.paramagic\temp

Note: If you are using OpenModelica as the core solver, ensure that the working directory field does
not have any spaces.

3. Solver Timeout - This variable is used to specify the time interval in seconds—measured after
pressing the Solve button in the ParaMagic® browser—after which ParaMagic® will disconnect from
the external solver (e.g. Mathematica / PlayerPro / MATLAB). Note that this will not kill the solver
runtime process. However, ParaMagic® will not wait for the solution results. By default, the value of
this variable is set to -1 which indicates no timeout.
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MATLAB M-File Default Location - This variable is used to specify the default location of MATLAB
M-files (functions or scripts) when using the ParaMagic-MATLAB Connection capability (see
section 8.3). Though the location of MATLAB M-files can be specified for each constraint block
wrapping the file, it is sometimes useful to specify a default location. ParaMagic® checks if the
location of the M-file is specified in the constraint block. If not, ParaMagic® will check for the M-file
in the default location specified here.

Browser Display Precision - This variable is used to specify the max number of decimal places to
display for values in the ParaMagic® browser. If the default value (-1) is specified, location-specific
default settings will be used, for e.g. displaying 3 decimal places in US.

Show Stats — When this variable is set to true, ParaMagic® will show statistics about the parametric
model (during validation/execution) in the MagicDraw message window.

Mathematica / PlayerPro Kernel - This variable is used to specify the location of the MathKernel
executable file in Mathematica or Player Pro installation. This variable is used only for Windows and
Mac operating systems. For Linux, a symbolic link /usr/local/bin/math must exist that links to the
math kernel available with PlayerPro or Mathematica installation. Refer to the Installation section
(Step 3a in section 4.2) for details on setting this variable for Windows, Mac, and Linux. This
variable is used only if Core Solver variable is set to Mathematica / Player Pro and if Use Local Solver
variable is set to true.

Log Message Level - This setting allows users to control the verbosity of log messages displayed in
the MagicDraw Message (Console) Window when using ParaMagic®. The default verbosity is
WARNING, i.e. all messages with severity of warning or above (such as error) will be shown.

Local vs. Remote core solver

9.

10.

11.

12.

13.

Use Local Solver - This variable is used to specify if ParaMagic™ should use local or remote solver.
In the current version of ParaMagic®, this setting applies only to Mathematica. If set to true,
ParaMagic® will use Mathematica installed on the user’s machine. If set to false, ParaMagic® will
use the Mathematica server available remotely.

Remote Solver — Host URL —This variable is used to specify the location of remote Mathematica
server (if Use Local Solver variable is set to true above). Values are specified in the following format:
IP number (or alias): port number.

Remote Solver — Access Key - This variable is used to specify the access key for the remote
Mathematica server (if Use Local Solver variable is set to true above).

Remote Solver — Retry Limit - This variable is used to specify the number of times ParaMagic® will
retry connecting to the remote Mathematica server if it is unable to connect to the server in the first
try (e.g. due to network issues). This value is used only if Use Local Solver is set to true.

Remote Solver — Time between Retries — This variable is used to specify the time interval (in
milliseconds) after which ParaMagic® will retry connecting to the Mathematica server if it is unable
to connect to the server in the first try (e.g. due to network issues). This value is used only if Use
Local Solver is set to true.
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Mac and Linux-specific settings — These settings are applicable only when using ParaMagic® on Mac or
Linux operating systems.

14. openModelica Installation Location — This variable is used to indicate the location of OpenModelica
(omc file) on Mac OS X, for e.g. /opt/openmodelica/bin/omc. This variable is used only if the core
solver is set to OpenModelica. This variable does not need to be set for Linux.

15. MATLAB Installation Location — This variable is used to set the location of MATLAB executable
(matlab file) on Mac or Linux, e.g. /Applications/MATLAB_R2014a.app/bin/matlab. If you are using
MATLAB on 32-bit Mac platform, then append the location with “ -maci”, e.g.
/Applications/MATLAB_R2014a.app/bin/matlab -maci

7.4 ParaMagic® Working Folder

During operation, ParaMagic® saves working files for models in the same location as MagicDraw
working folder. Example locations for Windows and Mac are provided below.

e On Windows 7, this location is:
<Your user dir>\AppData\Local\.magicdraw\18.0\plugins\com.intercax.paramagic, such as
C:\Users\InterCAX\AppData\Local\.magicdraw\18.0\plugins\com.intercax.paramagic

e On Windows XP, this location is:
C:\Documents and Settings\<Your user dir>\Local Settings\Application
Data\.magicdraw\17.0.5\plugins\com.intercax.paramagic

e On Mac OS X, this location is:
<Your user dir>/.magicdraw/18.0/plugins/com.intercax.paramagic, such as
/Users/InterCAX/.magicdraw/18.0/plugins/com.intercax.paramagic

The ParaMagic® Working Folder includes a temp folder that stores files created by ParaMagic® when
solving parametric models. It also includes the paramagic_silent and paramagic_silent_targets log files
that are created when using ParaMagic® Silent feature (section 10). The ParaMagic.ini file located here
should never be edited manually.

-~

Mame Date modified Type Size

J temp 8/8/2014 12:49 PM File folder
i | ParaMagic 8/6/2014 7:16 PM Configuration set... 2 KB
| paramagic_silent B/8/2014 12:532 PM Text Document 2 KB
|| paramagic_silent_targets 8/8/2014 12:52 PM Text Document 1 KB

Figure 37: ParaMagic® Working Folder
8 CONNECTIONS TO EXTERNAL TOOLS

8.1 ParaMagic - Custom Mathematica Connection

The ParaMagic - Custom Mathematica connection (a.k.a cMathematica) exposes full power of
Mathematica to ParaMagic users through the cMathematica function. This allows “wrapping” of both
pre-defined and user-written Mathematica functions—saved as .m files in the Mathematica Autoload
folder—as constraint blocks. Nine pre-defined graphing functions and three statistical functions are
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included with ParaMagic™. The user can create as many custom functions as desired if he or she has
familiarity with Mathematica function programming and access to the Mathematica directory structure.
The canonical form of the constraint expression is:

output parameter = cMathematica(function name, input arguments)
and would be used in a parametric diagram as shown in Figure 38.

par [Block] StatFn [ [£5 StatFn ]J

==constraint==
HormalTest : Hormal

12 = chlathematicaProbDistFnMarm = m,s1}

[ ] x:Real [ |m: Real [ ] s:Real [] e
: : e : : = : : : el : : : cReal
X:Real |- . Mean : Real . Sigma : Real . . PDF1: Real

Figure 38: Constraint Expression using cMathematica Function in Parametric Diagram

The Orbital tutorial provided with ParaMagic™ demonstrates an example usage of a graphing function
provided by cMathematica feature. It is located under
<MD_Root>\samples\ParaMagic\Tutorials\Orbital.

This feature is not supported if OpenModelica or MATLAB SMT is selected as the core solver.

8.1.1 Installation

A library of pre-defined Mathematica graphing and statistical functions is provided with ParaMagic®
16.9. After ParaMagic™ installation, this library is located here:
<MD_Root> \plugins\com.intercax.paramagic\xfw\conf\ICAX.zip. If you are using local Mathematica,
right click on the ICAX.zip file and extract it to <Your Mathematica Installation>\SystemFiles\Autoload
folder. For example, if you have local Mathematica version 7.0 on your Windows machine, extract
ICAX.zip t0 C:\Program Files\Wolfram Research\Mathematica\7.0\SystemFiles\Autoload. If you are
using XWS-based Mathematica, ask your system administrator to extract ICAX.zip to your Mathematica
server installation. If you are evaluating ParaMagic™ and using our test server xws.magicdraw.com, then
you do not need to follow the steps above. The library is already extracted in the Mathematica installation
at xws.magicdraw.com and ready for you to evaluate.

Note: After extracting ICAX.zip file to C:\Program Files\Wolfram
Research\Mathematica\7.0\SystemFiles\Autoload folder, verify that the Autoload folder has an ICAX
folder and Mathematica .m files inside the ICAX folder. There should not be an ICAX folder inside the
ICAX folder.

8.1.2 Usage

Tutorial 6 (Orbital) in the ParaMagic tutorials describes the process of using the pre-defined graphical and
statistical Mathematica functions (sections 8.1.3 and 8.1.4 below). See section 6.2, Step 1V, in ParaMagic
Tutorials document for details. Note that the ParaMagic Constraint Block Library package—Iloaded with
the ParaMagic Profile—has a generic cMathematica_Function constraint block that can be copied (in
your package) and used in the manner described in Tutorial 6.
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ParaMagic™ allows users to specify the location of the plots created by the Mathematica graphing
functions. The location can be specified for each constraint block that wraps a Mathematica function. The
tag working_dir (owned by the stereotype External_Model) is populated for the constraint specification in
the constraint block to specify the location—also described in Tutorial 6. The behavior of ParaMagic with
respect to the working_dir tag is as below:

1) If the tag working_dir is populated and
a) the folder location exists, ParaMagic® will pass the location as the first argument to the
Mathematica function.
b) the folder location does not exist, ParaMagic® will show an error message to the user.

2) If the tag working_dir is not populated, ParaMagic™ will not pass the location to the Mathematica
function. Therefore, the invoked Mathematica function should not expect its first argument to be the
folder location.

Note that the working_dir tag is used to pass the location of a folder to a Mathematica function. This
folder can be used for exporting plots or other forms of outputs (e.g. .txt or .csv files with the results).

Both input and output parameters of the constraint block wrapping the cMathematica function can be
single-valued or multi-valued (e.g. an array of real number) but not a complex data structure (e.g. multi-
dimensional arrays).

8.1.3 Graphing Functions

Nine pre-defined graphing functions have been created to provide quick access to some of the two-
dimensional plotting functions in Mathematica. In the interests of simplicity, the flexibility of these pre-
defined functions is limited. Users familiar with Mathematica function programming may want to create
their own routines.

These nine functions have several common features:

o When executed, each function creates and saves a plot file with a fixed name to a location specified
by the user. Calling the function a second time will over-write the first file. The location of the plot
file is specified in the constraint block used in the model.

e Each function returns a single parameter (single value real) to ParaMagic® on completion of the
function, with a value of 1.

e The input arguments can include numeric data, expressed as real single value or aggregate data, and
strings which appear as labels on the plot. The strings cannot be entered as variables (constraint
parameters); they must be explicitly fixed in the constraint specification.

e Blank spaces are not allowed in the names of the output and the input parameters of the cMathematica
function.

¢ In the following table, Title will be displayed as the title of the graph, XAxis will be displayed as the
horizontal axis label and Y Axis will be displayed as vertical axis label. Strings must be enclosed in
quotes, e.g. “Power versus Time”. Since plot and axes labels are also input arguments to the
cMathematica function, blank spaces are not allowed. For example, if the plot title is “Power versus
Time”, ParaMagic™ will throw an instance parsing error.

e It is frequently convenient to create a hyperlink in the MagicDraw model pointing to the output file
created. For model portability, it is recommended to define the hyperlinked location relative to the
MagicDraw installation. You may use <install.root> to refer to your MagicDraw installation. For
example, <install.root>\plugins\com.intercax.paramagic\xfw\conf\PlotXY.jpg will automatically
resolve to the plot file location.
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Note: If you are using PlayerPro as the core solver, you will be prompted for a front-end program when
solving parametric models that use these graphing functions. When prompted, select the
WolframPlayerPro executable file on your computer. This is the main program located in your PlayerPro
installation, e.g. C:\Program Files\Wolfram Research\Wolfram Player Pro\9.0\WolframPlayerPro.exe

Function Output Description

. Plots a line graph of the x values vs. {1,2,3,...}
ICAXPlotX PlotX jpg z =cMathematica(ICAXPIotX,x, "Title”, “XAxis”, “YAxis")
Plots a line graph of x vs. t values
ICAXPlotXT LinePlotXT.jpg Z =cMathematica(ICAXPIotXT,t,x, Title”, “XAxis",
“YAXxis")
Plots a two line graph of x and y values vs. {1,2,3,...}
ICAXPlotXY LinePlotXY .jpg Z =cMathematica(ICAXPIlotXY,x,y, Title”,
XAxis"”,"YAxis")
Plots a two line graph of x and y values vs. t values
ICAXPIotXYT LinePlotXYT.jpg z =cMathematica(ICAXPIotXYT,t,x,y,"Title”, “XAxis",
“YAxis")
Plots a scatter plot of y vs. x values
ICAXPlotXYScatter | ScatterPlotXY .jpg z =cMathematica(ICAXPlotXYScatter,x,y, "Title”, “XAxis”,
“YAXxis")
Plots a bar chart of the x values vs. {1,2,3,...}
ICAXBarChartX BarChartX.jpg z =cMathematica(ICAXBarChartX,x, Title”, “XAxis",
“YAxis")
Plots a double bar chart of x and y values vs. {1,2,3,...}
ICAXBarChartXy | BarChartXY.jpg z =cMathematica(ICAXBarChartXY,x,y, "Title”, “XAxis”,
“YAxis")
Plots a pie chart of the x values vs. {1,2,3,...}
z =cMathematica(ICAXPieChartX,x, "Title")
Plots a histogram of the x values vs. {1,2,3,...}
ICAXHistogramX HistogramChartX.jpg | z =cMathematica(ICAXHistogramX,x, Title”,“XAxis",
“YAXxis")

ICAXPieChartX PieChartX.jpg

8.1.4 Statistical Functions

Three pre-defined statistical functions have been created to provide quick access to some of the statistical
power of Mathematica.

Function Description

Returns the probability distribution function for outcome k in a binomial
ProbDistFnBinom | distribution of n trials and success probability p (k and n integers)

c =cMathematica(ProbDistFnBinom,n,p, k)

Returns the probability distribution function for value x in a normal
ProbDistFnNorm | distribution with mean m and standard deviation s

c =cMathematica(ProbDistFnNorm,x,m,s)

Returns the probability distribution function for value k in a Poisson
ProbDistFnPois distribution with mean m (k integer)

c =cMathematica(ProbDistFnPois,m,k)

8.1.5 User-Defined Mathematical Functions

A user familiar with Mathematica function programming can easily create and use custom Mathematica
functions within SysML parametric diagrams with the cMathematica capability. There are two ways to
creating custom functions, using one of the five preset UserfnN.m functions (where N runs from 1 to 5)
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or creating a new function using one of the existing pre-defined functions as a template for compatibility
with ParaMagic.

8.1.6 UserfnN.m

Within the ICAX library with the pre-defined graphing and statistical functions, we have provided five
“empty” functions. Each one can be edited using Mathematica or any standard text editor. Replace the
comment lines

(* :Add Mathematica code calculating output b from inputs t and m *)
(* :To save graph, Export["GraphFileName", GraphFunction[arguments]] *)

with valid Mathematica code, which will be executed when the function is called.

Note that only two input arguments are defined in the function definition. This number can be reduced or
increased with appropriate modification of the template. Output and input parameters can be single-
valued or multi-valued (e.g. array).

8.1.7 Custom Functions

The user can write his/her own Mathematica functions using the cMathematica capability. We
recommend using one of the pre-defined functions as a template to insure compatibility with ParaMagic.

In order for a function to be recognized by Mathematica, it must be autoloaded on start-up. See the

Mathematica user documentation for discussion on declaring and loading functions. One easy way to

accomplish this is to

e Save the new .m file in <Mathematica installation directory>\SystemFiles\Autoload \ICAX

o Edit the Master.m and Kernel\init.m files in the ICAX folder to declare the new function. Add the
lines

DeclarePackage["ICAX NewFunctionName™", {"NewFunctionName"}]

to each of these files and save, where NewFunctionName is the name of the new function, without the
.m extension.

8.2 ParaMagic - Excel Connection

The ParaMagic - Excel Connection (PM-EC) allows users to perform two key functions:
e Generate / Update SysML instance model structure from Excel spreadsheets
e Read/Write instance slot values from/to Excel spreadsheets.

This enables users to quickly generate topologically variant system architectures (as instance models),
perform parametric analyses on these architectures, and export results for plotting and presentation to
spreadsheets. In section 8.2.1 the capability to generate instance models from Excel spreadsheets is
presented, and in section 8.2.2 the capability read/write instance slot values from/to Excel spreadsheets is
presented.

8.2.1 Generate/Update SysML Instance Model Structure from Excel
Spreadsheets

In this section, we present a step-by-step process for generating SysML instances from Excel
spreadsheets. For simplicity, we will first describe the process for primitive blocks and then for complex
blocks. A primitive block is one that has no part/reference/shared properties. These blocks represent the
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leaf-level systems/parts in a system hierarchy. A complex block is one that has part/reference/shared
properties.

8.2.1.1 Creating instances of a primitive block

1. Suppose you have a table of Control system instances (alternatives) in Excel spreadsheet as shown
below. The columns represent properties of the Control system. This table may have been developed
independently of the SysML model, so the names of properties (e.g. Power and Weight) may not
correspond to the property names in the SysML model and the table may have more columns than
required/relevant for SysML instances.

A B C

1 _I

2 Control Instances

3 Name |Power (KW) | Weight (kgs)

4 Q1 1000 2000
S |C2 2000 3000

6 C3 3000 4000
7 C4 A000 S000
TR Sheetl . Sheet [N | r

Figure 39: Example spreadsheet with instances of Control system

2. Now suppose you have a primitive block (e.g. Control) in the SysML model with value properties
Pcon and Wcon. The block may have been defined in the SysML model or defined in a separate
model that is imported as module (library), as shown below in Figure 40.

B Co.. [& str.. [ & In.. | Dia.. <= Mo..

Containment L ¢
B ORY B
E-E= Data
B[ Satellie

[~ Relations

B 3atelitespecification

B YalueTypes
2=
b O +Pcon ¢ Kiloweatt
L I+ : kilogram
BB Instruments
E-E3 PowerBalance
B PowerSystem
B Propulsion
£
£

t-= Satellitesystem
f-E5 WeightBalance

SateliteEDD
- 5| SatelitsRents
Figure 40: Control block in the SysML model
3. Import the ParaMagic profile into your model if it is not imported already. To import the profile, go
to File > Use Module in MagicDraw, select <install.root>\profiles, select ParaMagic Profile (as shown

below), and then press the Finish button.
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Select module file
() From file system

(@) From predefined location

Project modules paths:

<project.dir »

<install.root=‘profies
<inztall.root=YmodelLibraries

[ ¥ Networking_Profile

E Orade DOL constraints

----- | Orade_DDL_Profile

OrchestraProfile

----- OrchestraProfile. mdzip. bak
&

E ParametricExecutionProfile

i Patterns_Profile,xml

ProActivity Profile.xml

Relationships_Profile. xml

F_igure 41: Import the ParaMagic Profile
4. To generate instances of the Control block from the table in the spreadsheet, right click on the Control

block in the MagicDraw Containment tree and select ParaMagic > Excel > Create Instances from
Excel. You will see the ParaMagic instance creation utility, as shown below.

0 e s o o I ==
|

Step 1: Select Package

Select package for new instances.

Package Sz ]

Step 2: Select Workbook

Select Excel workbook and worksheet that have instance information.

Workbook File

Step 3: Connect Workbook to Instances

Check “Implicit™ if header row has names of block properties. Else, uncheck “Implicit™ and
specify columns for block properties.

Al f Mum Insta... |1

Implicit - header row has names of block prope... Header Row 1
Instance Name Colu... |A 1stInstance Row |2
Block Properties Excel Column Package

Cancel |

Figure 42: ParaMagic instance creation utility
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5. In Step 1, press the Browse button to select an existing package for instances or create a new package
(e.g. Control_Instances) as shown below. If selecting an existing package, press OK. If creating a new
package, press Enter and then OK.

EJ Data
- Satelite

E ValueTypes

: E sateliteSpedfication
i Constraint Block Library (read only)

------ |j| k:::unh'nl_lnstances |

Mew... QK. Cancel

Figure 43: Creating a new package to store instances

6. In Step 2, select the workbook and worksheet containing the instance table (Figure 39). An example
screenshot of the instance creation utility at the end of this step is shown below.

Step 1: Select Package

Select package for new instances.

Package Instances::Control_Instances - Browse. ..

Step 2: Select Workbook

Select Excel workbook and worksheet that have instance information.

Workbook File  |Satellite_Instances. xlsx Browse...
Worksheet _ﬁhggtl iv Refresh

Step 3: Connect Workbook to Instances

Check "Implicit” if header row has names of block properties. Else, unchedk "Implicit™ and specify
columns for block properties.

All { Num Instances |1

Implicit - Header Row has names of block properties Header Row 1
Instance Mame Column |A ist Instance Row 2
Block Properties Excel Column Package
OK Cancel

Figure 44: ParaMagic instance creation utility after specifying package and workbook/worksheet information
7. In Step3, you will connect the SysML model to the Excel spreadsheet, i.e. specify the mapping

between the properties of the SysML block that you want to instantiate and the columns in the Excel
spreadsheet. There are 2 ways to specify this mapping:

Copyright © 2014 InterCAX LLC. All Rights Reserved. o9



ParaMagic® 18.0 e Users Guide

a. Implicit — In this mode, the header row of the Excel table has the names of block properties. For
the table shown in Figure 39, this is not the case. The property names Power and Weight in the
header row (Row 4) are not the same as names of value properties of the Control block (PCon and
WCon). Check Implicit if this is the case for your models, as shown in Figure 43. If the Implicit
option is selected, specify the header row number (e.g. 4).

b. Explicit — In this mode, users have to explicitly specify what columns in the Excel table
correspond to the block properties. For e.g. specify column B and C for PCon and WCon as
shown below. Specify the columns that contain the instance names (e.g. A) and the first instance

row (e.g. 4).
Step 1: Select Package
Select package for new instances.
Package :Instances: :Control_Instances -
Step 2: Select Workbook
Select Excel workbook and worksheet that have instance information.
Workbook File | Satellite_Instances. xlsx
Worksheet :Sheetl -
Step 3: Connect Workbook to Instances
Check "Implicit” if header row has names of block properties. Else, uncheck “Implicit” and specify
columns for block properties.
[T All { Num Instances |4
[”] Implicit - Header Row has names of block properties Header Row 1
Instance Name Column |A 1st Instance Row 4{
Block Properties Excel Column Package
] control
Ml Fcon B
L. Weon
Figure 45: ParaMagic instance creation utility after specifying explicit mapping between Excel columns and value
properties

8. Next, select “All” if you would like to generate block instances for all the rows in the Excel table
(until ParaMagic finds an empty row), or specify the number of instances (e.g. 4) as shown in Figure
42 above.

9. Press OK.

10. You should now see instances generated in the SysML model, as shown below in
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Figure 46: SysML instances created by ParaMagic from Excel table

Eltl Control_Instances

I_'—_}EI C1 1 Conkral

11. When generating instances from Excel spreadsheets, ParaMagic also establishes a connection
between instance slots and the cells in Excel tables. This allows users to automatically read/write
values from/to Excel spreadsheets to/from SysML instances. For e.g. right click the instance C1 in the
MagicDraw containment tree (shown above) and select ParaMagic > Excel > Setup. You can see the
connection between the slots (PCon and WCon) of C1 and the corresponding cells in Excel tables. If
you update values in the Excel table and invoke ParaMagic > Excel > Read on the individual SysML
instances or the owning package (e.g. Control_Instances), ParaMagic will update the values in the

SysML instance model.

B-= 1

~oZm
L @ Weon

Workbook/Worksheet

Default Workbook  Satellite_Instances.dsx

Default Worksheet | Sheet1

Cell Selection

Cell Range B4

Access Mode @ Read Write Mone

Excel Preview {}

Current Value { 1000.0}

-

-

Browse...
Refresh

Preview

Clear

[

Figure 47: Instances generated by ParaMagic are connected to Excel tables for value sync.

12. If you attempt to generate instances from Excel tables in a package that already contains instances
with the same names as you are attempting to generate, ParaMagic will offer to overwrite the

instances in the package.
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8.2.1.2 Creating instances of a complex block

1. Suppose you have a complex block with several part/reference/shared properties as shown below for
the SatelliteSystem block. In this example, the SatelliteSystem block has four part properties.

ehlocks
SatelliteSystem
values
Weight : Kilogram
Weight_MOS : Real
Power_MOS : Real
constraints

weight1 : WeightBalance
power1 : PowerBalance
PMOS : PowerMOS
VWMOS : WeightMOS

Pro1 Ins1 Con1 I Psy1 I
zblocks «blocks «blocks eblocks
Propulsion Instruments Control PowerSystem
values values values values
Ppro : Kilowatt Pins : Kilowatt Pcon : Kilowatt Power : Kilowatt
Wpro : Kilogram Wins : Kilogram Wecon : Kilogram Wpsy : Kilogram

Figure 48: Example of a complex block (SatelliteSystem)

2. First, generate instances for each of the primitive blocks from Excel tables, such as instances of
Control, PowerSystem, Propulsion, and Instruments blocks from the tables shown in Figure 49 below.
Use steps 5-9 of the process outlined in section 8.2.1.1 above. Example SysML instances generated
for the table in Figure 49 are shown in Figure 64 below.
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WD |00 (=~ | h (LA (W R

A B C

Control Instances

Name | Power (KW) | Weight (kgs)
Cc1 1000 2000
Cc2 2000 3000
C3 3000 4000
Cc4 4000 5000
Power Instances
Name Power Weight
P1 1000
P2 2000
P3 3000
P4 4000
Propulsion Instances
Name Power Weight
PR1 500 3000
PR2 1000 4000
PR3 1500 5000
PR4 2000 6000
Instrumentation Instances
Name Power Weight
11 1000 1000
12 1000 2000
13 1000 3000
14 1000 4000

Figure 49: Excel tables for Control, PowerSystem,
Propulsion, and Instrumentation instances

Containment

e o H3BY -5

B-f5 Data

E Constraint Block Library [Constraint Elock Library, mdzip]

B0 Instances

E| Control_Instances

I_——_|E| Instrurmentation_Instances
E-E 1 : Instruments

-2 Pins = "1000.0"

------ = wins = "1000.0"
=3 12 ¢ Instruments

() Pins = "1000,0"
(5 Wins = "2000,0"

= I3 ¢ Instruments

E- =1 P4 : PowerSystem
i (53 Poweer ="

== PRZ : Propulsion
i@ Ppro = "1000,0"
- {2) Wpro = "4000.0"
== PR3 @ Propulsion

B-= PR Propulsion
----- & Ppro="z000.0"
LS Wpro = "6000,0"

-

m

-

Figure 50: Instances generated from Excel tables for

Control, PowerSystem, Propulsion, and Instrumentation

3. Now suppose you have an Excel table (as below) that shows different instances of the SatelliteSystem

and the corresponding instances of the Control, PowerSystem, Propulsion, and Instruments block.

E F G H |
15
16 Satellite Systems
17 Name Prol Insi Conl Psyl
18 51 PR1 11 Cl P1
19 52 PR2 12 c2 P2
20 53 PR3 13 Cc3 P3
21 54 PR4 14 Cc4 P4

Fingg 51: Excel table showing instances of a complex block (e.g. SatelliteSystem)
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4. To generate instances of the SatelliteSystem block, right click on the block in the MagicDraw
Containment tree, and select ParaMagic > Excel > Create Instances from Excel. You will see the
ParaMagic instance creation utility, as shown below.

Step 1: Select Package

Select package for new instances.

Package :Insmnces: :SateliteSystem_Instances -

Step 2: Select Workbook

Select Excel workbook and worksheet that have instance information.

Workbook File | Satelite_Instances.wsx
Worksheet Sheet1 -

Step 3: Connect Workbook to Instances

Chedk "Implicit™ if header row has names of block properties. Else, unchedk “Implict” and spedfy
columns for block properties.

[ All { Mum Instances |4

[ Implicit - Header Row has names of black properties Header Row i
Instance Mame Column |F 1st Instance Row 15
Block Properties Excel Column Package
] satelliteSystem
G Instances: :Propulsion_Instances
H Instances::Instrumentation_I...
i I Instances::Control_Instances
&1 Weight
Hd Psyl ] Instances::PowerSystem_Inst...
&[0 Weight_MOS
L] Power_MOS
OK. Cancel

Figure 52: ParaMagic instance creation utility — creating instances of SatelliteSystem block

5. For generating instances of complex blocks, you must use the Explicit mode. Set Num Instances (e.g.
4), Instance Name Column (e.g. F) and 1% Instance Row (e.g. 18) based on the Excel table (e.g.
Figure 65).

6. Specify the Excel columns corresponding to the part properties of SatelliteSystem block, such as
column G for Prol (Propulsion instances), column H for Ins1 (Instruments instances), and so on.

7. For each part property, select the package in the SysML model that contains the instances used in the
Excel table. For e.g. the package Control_Instances contains instances of the Control block (C1, C2,
C3, and C4). ParaMagic will search these packages to find instances based on the names used in the
Excel table (e.g. PR1, 11, C1, and P1). If unsuccessful, the part properties (slots) for the
SatelliteSystem instances will not be populated.

8. Press OK
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9. The MagicDraw containment tree should show you all the four SatelliteSystem instances and
references to corresponding instances of Control, Power, Instrumentation, and Propulsion blocks, as
shown below. Note that this instance model corresponds to the Excel table shown in Figure 51 above.

'ﬂg Containment

Containment wl X
G <
El-E7 SatelliteSystem_Instances -
Bl =1 51 : SateliteSystem
----- S Conl =101
----- = Insl =11
----- = Power_MOS ="
----- = Prol =PRI
..... @ Psyl =Pl
----- (2 Weight_Mos ="
..... @ Weight ="
= 52 : SateliteSystem
----- S Conl =2
----- = Insl =12
----- = Power_MOS ="
----- = Prol = PRZ
..... @ Psyl = P2
----- (S Weight_Mos ="'
..... @ Weight ="
= 53 : SateliteSystem
----- & Conl =03
----- = Insl =13
----- = Power_Mos=""
----- = Prol = PR3
..... @ Pyl = P3
----- (S Weight_Mos ="'
..... @ weight ="
= 54 : SateliteSystem
----- & Conl =4
----- = Insl=14
----- = Power_Mos=""
----- = Prol = PR4
----- = Psyl =P4
----- ) Weight_MOS ="
----- & weight ="
- Satelite [Satelite_Blodk_Library  mdzip]
,.'-'" Relations o
] | Tl | 3

m

Figure 53: MagicDraw Containment tree after generating instances of SatelliteSystem

10. Similar to generating instances for primitive blocks, ParaMagic also creates Excel connections
between slots (corresponding to value properties) and Excel tables when generating instances for
complex blocks. Invoke ParaMagic > Excel > Read from Excel or Write to Excel to read/write values
from/to Excel tables to/from SysML model.
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11. Updating instance structure in Excel tables and re-generating: If you change relationships
between instances in the Excel table, such as changing the Instruments and Control block instances
associated with SatelliteSystem S1 to 12 and C2 (originally 11 and C1) respectively, and try to re-
generate SysML instances from the updated table in the same package that contains instances S1-S4,
ParaMagic will offer to update the SysML instances. For the example shown below, ParaMagic will
update the values of slots Ins1 and Conl of the instance S1 to 12 and C2 respectively.

Satellite Systems

Name Prol | Ins1 Conl Psy1
S1 PR1 | 12 Cc2 P1
S2 PR2 | 12 Cc2 P2
S3 PR3 | I3 c3 P3
S4 PR4 |14 (o} P4

Figure 54: Updating instance structure in Excel table

8.2.2 Update SysML Instance Model Values from Excel Spreadsheets

If you generate instances from Excel tables, as demonstrated in section 8.2.1, ParaMagic® sets up
connections between the generated instances and the Excel tables for automated reading/writing of values
between SysML instance slots and Excel cells. However, if you have manually created block instances in
a SysML model and intend to connect them to Excel spreadsheet(s) to read/write values, follow the steps
described below.

For reference, the Orbital tutorial provided with ParaMagic™ presents a usage of this feature. Refer to the
tutorial document and the Orbital model at locations shown below.

e ParaMagic® tutorial document : <MD_Root>\samples\ParaMagic\Tutorials\Tutorials.pdf

e Orbital model : <MD_Root>\samples\ParaMagic\Tutorials\Orbital

8.2.2.1 Operation
Follow the steps below to connect slots of manually created instances to Excel spreadsheets.

Step 1. Initialize slot

Each slot that needs to interact (read/write) with Excel spreadsheets must be initialized. Initialization
ensures that the slots are visible in the MagicDraw containment tree from where ParaMagic® operations
can be invoked. For initializing a slot:

a) Double click an instance in the MD containment tree. A specification window opens as shown
below in Figure 55.

b) Select a slot that needs to interact with Excel spreadsheets and click on Create Value button. For
example, slot a2 is selected in Figure 55.

c) After initialization, a slot will appear with one empty value, as shown for slot al in Figure 55.
Initialized slots will also be visible in the containment tree under the parent instance, as shown for
slots a1, a2, and a3 of Instancel in Figure 56.
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[X Instance Specification - Instancel

B (B ® « =+

History :| = Instancel : Vectoraddition: :Alpha [Yectoraddition: : Instance] vl

Usage in Diagrams
Deployed Artifacts
Inner Elements
Relations

Tags

Constraints

=1 Instancel : VectorAddition:: Al Slaks
Dacumentation/Hypetlinks

¢
ot ot 15 - ~[H

Create Valus

Close

Property:

| ——

Select property and click Create Value to

create new value For it.

Figure 55: Initialize slots

~" 'He Containment

Conkainmenk

Ee e}
o m =

B Data

E+FT Yectoraddition
B3 alphal
E-F7 alphaz
&7 alphas
ED Instancel
[ B-E
@ al
e (E) az=""
By A3 ="
Q Alpha
Q C45_heading

torAddition: :Alpha

B[ Paralagic Profile [ParaMagic Profile. mdzip]
@ Code engineering sets

Figure 56: MagicDraw Containment tree after initialization of slots.

For multi-valued slots (e.g. slots that store an array of numbers), the initialization process is the
same as above. For initializing multi-valued slots that are not inputs (givens) for ParaMagic™

simulations, see step 9 below.

Step 2. Setup Excel slots to interact with Excel worksheet

To setup slots to interact with Excel, right click on the slot (or its parent instance) in the MD
containment tree and select ParaMagic > Excel > Setup, as shown in Figure 57 below. The ParaMagic

Excel Setup utility appears, as shown in Figure 58 below.
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H 2 Alocate
- <Excel_Connection_nstances
New Element » PR
[ Shape - y
New Relation L3 | =Bicel_Connection_hstances ‘aBxod_Ginnection_stancen '::_V.M: il
: spald : Spacecraft oo
= spad ; 5p Open in New Tab orbd : Orbital B ] 7 e
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Ll Instancent Specification Enter — = 2ot ) == = ot )
e P pefinition Di... Flag= MaxPaonerBudgst =
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» L |
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- 1Pl Refactor » fraintBlock PowerSupply = et e
XmitDemand = " ancel_workstest = “Shoet1”
B1-5 InPkgz Select in Structure Tree in v HmitSupply = "™ Power= "
B8 InPlg Related Elements » |TiPe v Tl
- Mission leration
-5 orbital Tools e 1 <Excel_Connection_hstances
K PowerSystem Stereotype , ami 01 Transmiter.
(- Spacecraft P pee [ porerar———
B Transmitter Rename F2 face — = Sheat ]
B0 VTPt cucel_Connestion_nstance: Power="
;. B Copy Ctrl+C Epecification R TR
) Mission Powers ™
3] Content Copy URL T Xmit="
3-[Eq Paratagic Frofile [R @iy | Paste Ctrl+V faceRe... = <Brcel Connection_instances
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o Cut Ctrl+X |t sk . -
W Delete Delete PowerQut=""
fed Ass
o
Create Symbol Ctrl+Shift+V |4 Agg -
Generate Report... b fedCom...
— Lightning b falization v
135 Zoom |} Documents ParaMagic 5 Validate
ages Window Simulation » Browse
= hd i ,
es were updated for "autosave_Satelite_Block_Library” P N Setu
2d share "ParaMagic Profile". Reg P
Profil Trade Study ¥ Read from Excel
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Figure 57: Launch Excel Setup utility for an instance/slot

G Excel setup - Averagepowerwindon T .
E-E= mis Workbook/Worksheet

"o
Default Workbook

-2 AverageXmitWindow
(S EffectivePowerBudget
- (S Effective¥mitBudget
El-Z orbitall

El-E1 orbl

{2} Flag

- (2 Powerlsage
- (2 Xmitllsage

=X

mission. xlsx Browse...

Default Worksheet | Sheet1 Refresh

Cell Selection

- Preview

Cell Range B4

AccessMode () Read @) Write

Excel Preview

it
i3

Current Value

- {2 MaxPowerBudget
-2 MaxXmitBudget
-2 PowerDemand
-2 PowerSupply
}@ ps

}@ MM

- S ¥mitDemand

- S ¥mitSupply

Figure 58: ParaMagic Excel Setup utility

The ParaMagic® Excel Setup utility can be invoked for a slot, instance, or a package for which a
default instance®® has been selected. When invoked, users can see the entire instance model in the

19 For details, see the command Util > Set default instance in section 7.1
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context of the selected instance. Then, users can click on specific slots and link them to Excel
spreadsheets.

If Excel connection-related information is already populated for the slot, corresponding values will be
shown in the setup window as shown in Figure 58 above.

Step 3.

Specify Excel connection for slots

Specify Excel connection information for all slots that need to be linked to Excel spreadsheets. To do
this, repeat steps a-f below for all such slots.

a)

b)

d)

Select the slot in the instance model shown in the setup utility (left pane). For example, the slot
AveragePowerWindow is shown selected in Figure 58.

Specify the location of the Excel workbook associated with the slot in the Workbook File field. If
the workbook file is located in the same folder as the MagicDraw file (mdzip), only the name of
the workbook file needs to be specified (with the extension .xlIs or .xIsx). Alternatively, click the
Browse button to select the workbook file. Note that storing Excel workbooks with the
MagicDraw file enhances the portability of the model. The MagicDraw model file and the
workbook files can be distributed together without system-specific folder location settings.

Select the worksheet associated with the slot. If you selected the workbook file using the Browse
button, the list of spreadsheets in that file is automatically available for selection. However, if you
manually entered the workbook file, click on the Refresh button to populate the list of
spreadsheets in the workbook file. Note that if the workbook file is not found, the list of available
worksheets will be empty.

If multiple slots owned by a single instance are linked to the same workbook and worksheet, it is
preferable to specify workbook and worksheet information at the instance level and then select
the Use Default Worksheet option for all such slots. Figure 59 below shows an example where
the Excel workbook and worksheet is specified for the instance mis. The slot
AveragePowerWindow (owned by this instance) uses the worksheet.

EE=] | Workbook/Worksheet S = ms WorkbookpWorksheet

L@ AveragePowerWindow @

----- @) AverageXmitwindow Default Workbook | mission, xdsx Browse... i (B AverageXmitWindow | Default Workbook | mission. sdsx

@ EffectivePowerBudget L @ EffectivePowerBudget

----- 8 EffectiveXmitBudget Default Worksheet | Sheet1 - Refresh i~ @ EffectiveXmitBudget | Default Worksheet | sheett Refres

B3 orbitalt @ orbital1

B orbl E-E orbl Cel Selection

i@ Flag e @ Flag -
1.-/@ PowerUsage IL/ (& PowerUsage CellRange b4 - Preview
i@ Thets @ Thets
L@ mitUsage || @ mitlsage Access Mode Read @ Write Nane

B8 spacecaftt Er @ spacecraftl "

B 15 mpat 221 o1 Excel Preview  {}
L@ MaxPowerBudget ([ e B MaxPowerBudget || oo o
Pe@ MaxxmitBudget || e B MaxXmitBudget
:--@ PowerDemand -8 PowerDemand
L@ Powersuply || e & Powersupply [ cex |
tof@ ¥mitDemand || e @ xmitDemand
L8 ¥mitSupply (@ XmitSupply
[ o< [ canesl ][ mpoy | [ o | cancal |F Rpal ]
Excel worksheet specified for the instance Slot uses the default worksheet

Figure 59: Specifying workbook and worksheet at the instance level and using it for slots
Note that ParaMagic® allows you to propagate default workbook and worksheet settings through
the instance hierarchy. For e.g. workbook and worksheets specified at the top-level instance (e.g.
mis) can be used as defaults for all lower level slots and instances (at any depth in the model).
Specify the cell range (in the selected worksheet) associated with the slot. Cell range can be
specified using cell name or address.
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If the cell range is specified using a name, the following rule applies:

i) The scope of the name should be the worksheet and not the workbook. For example, as
shown in Figure 60 below, cell range C6:C15 in Sheetl is named as PowerUsage. The scope
of this name is the worksheet Sheet1.

New Name EE
Hame: PowerUsage
Scope: Sheetl v

Comment:

[ OK l[ Cancel :]

L]

Refers to: | _sheet1!§C56:5C515

Figure 60: Specify cell range using name
If the cell range is specified using cell address, the following rules apply:

i) Cell range must be specified using the following Excel syntax:

(1) for multi-valued slots: <first cell address>:<last cell address>. For example, if a multi-
valued slot is to be associated with cells from A2 to A10, cell range should be specified
as A2:A10.

(2) for single-valued slot: <cell address>. For example, if a single-valued slot is associated
with cell A2, cell range should be specified as A2.

ii) Cell ranges must be specified without the worksheet reference. For example, cell range A2 to

A10 in MySheet worksheet should be specified as A2:A10 and not as MySheet1!A2:A10.

iii) A cell range should not have special characters (including whitespaces) that Excel cannot

recognize. The following are examples of syntactically incorrect cell ranges: A2 : A10,A2: A

10, A$%2:A*9

iv) For associating a SysML slot to an Excel spreadsheet using ParaMagic®, cell ranges must be
contiguous and correspond to a single column/row. For example, A2:A10 and A2:F2 are

contiguous and correspond to single column and row cell ranges respectively; A2:B10 is a

contiguous but not a single column/row cell range; and A2:A10,C2:C10 is a valid but non-

contiguous cell range.
v) ParaMagic® ignores the order in which the first and last cells are specified in the cell range
field. For example, A10:A2 is treated the same as A2:A10.

Specify the access mode (Read or Write).

If the Access Mode=Read, ensure that the workbook file is saved before the Excel Read operation
is executed. If Access Mode=Write, ensure that the workbook file is closed before the Excel
Write operation is executed. As shown in Figure 58, slots that are setup to read from spreadsheets
are shown in blue and slots that are setup to write to spreadsheets are shown in red.

Press the Apply button to save slot setup information to the MagicDraw model. Those slots for

which the Excel connection settings have been changed but not saved to the MagicDraw model
(Apply button) are shown in italics.
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The table below summarizes the commands that can be issued from the ParaMagic® Excel Setup utility.

Command Description

Browse Opens a file browser for selecting an Excel workbook file (.xIs or .xIsx)

Refresh Creates a list of spreadsheets available in the specified workbook file

Apply Saves the Excel connection settings to the MagicDraw model

OK Saves the Excel connection settings to the MagicDraw model (Apply) and closes
the setup utility

Clear Removes the Excel connection settings for the subject slot

Cancel Closes the ParaMagic® Excel Setup utility without saving the Excel connection
settings

Note: Since the workbook and worksheet information is specified for a particular slot, different slots in an
instance may be connected to different workbooks/worksheets and setup to Read/Write information
from/to Excel spreadsheets.

Step 4. Execute Excel Read / Write operation for the setup slot

Once a slot is setup, Excel Read or Write operations can be executed by right clicking the slot and
selecting ParaMagic > Excel > Read from Excel or Write to Excel menus. When the Read or Write
operation is executed successfully, corresponding information messages pop-up as shown in Figure
61.

During the Excel Read operation, the causality of all slot values read from Excel is automatically
changed to “given” (from “undefined”) in accordance with Table 1. Once a slot has been connected
to an Excel worksheet, the Excel Read/Write operations can be invoked whenever new values are to
be read from (or written to) the Excel worksheet.

Information

.
\E) Successful in reading values from Excel and assigning causaliies.

Message shown for successfully reading slot values from Excel

Information 3]

\l) Successful in writing values o Excel,

Message shown for successfully writing slot values to Excel

Figure 61: Information messages for successful execution of ParaMagic® Excel Read/Write operations
Steps 1-4 above demonstrate the basic use of ParaMagic™ to (1) connect SysML instance slots to

Excel spreadsheets, and (2) read/write values from/to spreadsheets to/from instance slots. Additional
steps for more efficient operations are described below.
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Step 5. Execute Excel Read/Write operation for an instance or an instance package

Excel Read/Write operations can be invoked for a slot (as demonstrated above), an instance, or a
package containing instances. To invoke Excel Read/Write operation on an instance (or instance
package), right click the instance (or instance package) and select ParaMagic—»Excel>Read from
Excel or Write to Excel menu.

If the Excel Read operation is invoked on an instance, ParaMagic® will execute the Excel Read
operation for all slots of that instance that are setup to read from Excel (Access Mode=Read).
Similarly, if the Excel Write operation is invoked on an instance, ParaMagic® will execute the Excel
Write operation for all slots of that instance that are setup to write to Excel (Access Mode= Write).

If the Excel Read/Write operation is invoked on a package, ParaMagic® will perform the Excel
Read/Write operation for all instances in the instance package.

Step 6. Initializing slots with empty values before solving with ParaMagic.

If a slot value is intended to be a target or an undefined variable for ParaMagic® solution, users are
still required to initialize the slot (as shown in step 1 above). If the slot value is an array, then n values
of that slot must be initialized (where n is the array size). This can be a cumbersome process. Using
ParaMagic®, users can initialize a slot with n empty values by setting them up to read values from n
empty cells in an Excel spreadsheet and then executing the Excel Read operation. If the slot values do
not have any pre-assigned causality, the Excel Read operation will set their causality to "undefined".
For those empty values that are the targets, users can change the causality from “undefined” to
“target” in the ParaMagic™ browser.

The table below summarizes the ParaMagic® commands for Excel setup/read/write, the model
elements for which these commands may be issued, their behavior, and the response message on
successful execution of commands. These commands are available under ParaMagic > Excel menu.

Command | Arguments | Description Messages
Setup Slot Opens the Excel Setup utility for the

instance owning the slot. The subject
slot is selected.

Instance Opens the Excel Setup utility for the
instance. The subject instance is
highlighted in the instance model.

Package Opens the Excel Setup utility for the
default instance in this package. To

After the Apply (or OK) button is
pressed, the setup values are
saved to the model. No messages
pop-up after the save operation

set a default instance, see the Is completed.
command Util > Set default instance
in section 7.1

Read Slot Reads values from an Excel e If slot values are read
spreadsheet and populates slot values | successfully from Excel and the
if slot access mode=Read. The causality assignment is
causality is set to "given" for all slot | successful, the response message
values read from Excel states "Successful in reading

values from Excel and assigning
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Write

Create
Instances
from Excel

Instance

Package

Slot

Instance

Package

Block

Executes the Excel Read operation for
all slots in the instance.

Executes the Excel Read operation for
all slots of all instances in the
package.

Writes slot values to an Excel
spreadsheet if slot access mode =
Write.

Executes the Excel Write operation
for all slots in the instance.

Executes the Excel Write operation
for all slots of all instances in the
package.

Generates instances of the block from
data in Excel tables

default causalities.”

o If slots values are successfully
read from Excel but the causality
assignment is unsuccessful, the
response message states
“Successful in reading values
from Excel but unsuccessful in
assigning causalities."”

e If slot values are not read from
Excel, response messages
(indicating the problems) are
shown in the MagicDraw
Message window.

A successful response message
is show only when the Excel
read and causality assignment
operation is successful for all
slots (with read access mode) in
the instance. Else, no response
message is shown.

A successful response message
is shown only when the Excel
read and causality assignment
operation is successful for all
slots of all instances in the
instance package. Else, no
response message is shown.

o [f slots values are successfully
written to Excel, the response
message states "Successful in
writing values to Excel".

e If slot values are not written to
Excel, response messages
indicate the problem.

A successful response message
is shown if the Excel Write
operation is successful for all
slots of the instance.

A successful response message
is shown only if the Excel Write
operation is successful for all
slots of all instances in the
instance package.
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8.2.2.2 Features and Specific Behavior

1)

2)

3)

4)

5)

Both versions of MS Excel files are supported—Excel 97-2003 files (.xls extension) and Excel 2007
files (.xIsx extension).

Both numeric and text (string) values can be read from Excel or written to Excel. If the block value
property corresponding to a slot is typed by:

a) value type Real or its subtype, ParaMagic® will read/write only numeric values for that slot.

b) value type String or its subtype, ParaMagic® will read/write values for that slot as strings.

c) any other value type, ParaMagic® will behave the same as (b) above.

ParaMagic® operations are one-time read/write operations and not a live connection. If values in
Excel workbooks (associated with slots in MagicDraw) are updated, the Read operation must be re-
invoked on all slots to read updated values after the Excel spreadsheet has been saved. Similarly, if
slot values in SysML instance model (associated with values in Excel workbooks) are updated, the
Write operation must be re-invoked to write updated values from SysML model to Excel spreadsheets
after the workbooks have been closed.

Empty cells in an Excel spreadsheet are read as empty slot values in the Excel Read operation.
Similarly empty slot values are written as empty cells in Excel spreadsheet in the Excel Write
operation. Note that cells that look empty (no contents) may be null (esp. if they have not stored a
value previously). In an Excel read operation, null cells are not read as empty slot values.

If a slot has “n” values and it is associated with “k” cells in a spreadsheet then the behavior of Excel
Read and Write actions invoked on the slot are specified in the table below.

Excel Read operation

n>=k n<k

e Only the first k values of the slot (has n values)
are updated with the values in k cells in the
Excel spreadsheet.

e The remaining values of the slot—(k+1)" value
to the n" value—are deleted.

e After a read operation, causality is assigned
based on Table 1 — if slot entry has a value, then
set to given or keep as target. If slot entry is
null, then assign/keep as undefined.

e The n values in the slot are updated with the
values in first n (out of k) cells in the Excel
spreadsheet.

o New slot values are created for values of (n+1)"
to the k™ cell in the Excel spreadsheet.

e Causality is assigned based on Table 1 — if slot
entry has a value, then set to given or keep as
target. If slot entry is null, then assign/keep as
undefined.

Excel Write operation

n>k

n<k

Excel write operation will not work if n is not equal to k. This is to avoid
overwriting existing cells in spreadsheets for ambiguous cases such as these.

8.2.2.3 Limitations
1)
instance or instance package.
2)
3)
example, A10:A2 is treated the same as A2:A10.
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Note: Although ParaMagic® is designed to ensure that existing features in Excel workbooks, such as
charts, formulas, macros, and pivot tables, are preserved when reading and writing values from/to
workbooks, all of these features are not tested with ParaMagic®. As an extra caution, ParaMagic®
creates a backup of Excel spreadsheets, at the same location as the original spreadsheet, before the Write
operation.

8.3 ParaMagic - MATLAB Connection

The ParaMagic — MATLAB connection (PM-MC) enables users to wrap MATLAB functions and scripts
as SysML constraint blocks and use them in parametric models as regular constraint properties.
ParaMagic™ solves for the constraints by invoking MATLAB functions/scripts when required.
MATLAB scripts are commonly used to invoke and execute Simulink models. Since PM-MC can solve
for constraints that wrap MATLAB scripts, it can be used to execute Simulink models and feed the results
of the execution back into SysML models.

The HomeHeating tutorial provided with ParaMagic is an example usage of the PM-MC feature. It is
located under <MD_Root>\samples\ParaMagic\Tutorials\HomeHeating. This model has been tested to
work with MATLAB 2014a.

A MATLAB script? is used for automatically executing a series of MATLAB commands. Users that
perform computations on MATLAB command line write MATLAB scripts which can be loaded in the
MATLAB environment to achieve the same effect. A script has no input and output arguments. However,
a script may create and access variables in MATLAB workspaces. In contrast, a MATLAB function®
accepts input arguments and has output arguments.

MATLAB scripts and functions are written in MATLAB files—commonly known as M-files. These files
also have a .m extension like Mathematica files. Users should be careful to distinguish a .m file native to
Mathematica versus a .m file native to MATLAB. A MATLAB M-file containing a script is known as a
script M-file, and a MATLAB M-file containing a MATLAB function is known as a function M-file.

If all relations in your SysML model are MATLAB relations (i.e. they wrap function or script M-files),
then ParaMagic™ does not require Mathematica to solve the model.

In the following two sections, the process of wrapping MATLAB scripts M-files and function M-files
using constraint blocks is demonstrated. Once wrapped, ParaMagic can invoke MATLAB
scripts/functions when the constraints need to be solved. Step 1 and 0 below are common to using script
and function M-files.

Step 1. Check MATLAB installation on your computer
Follow the steps below to ensure that MATLAB is installed correctly on your computer.

1) Go to the command prompt. On Windows, you may do this by selecting Run from the Start menu and
typing the command ecmd and pressing the OK button.

2) Type matlab at the command line. This should launch MATLAB on your computer.

3) Before wrapping MATLAB function or script M-files, ensure that they are correct, i.e. they have
valid MATLAB syntax and provide valid results for valid inputs. To do this, run the script M-file on

2 MATLAB scripts and functions: http://www.mathworks.com/access/helpdesk/help/techdoc/matlab_prog/f7-38085.html
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MATLARB installed on your computer, or call the function M-file from your MATLAB workspace.
Once MATLAB scripts/functions have been tested to work with MATLAB, then they are ready to be
used with ParaMagic™.

Step 2. Specify default location of MATLAB function/script M-files

It is preferred that users provide a default location (folder) of MATLAB function/script M-files. If the M-
file location is not specified with the constraint block (that wraps the M-file), ParaMagic will search for
the M-file in this default location. This behavior can used to your advantage if all (or most) of your M-
files are at the same location (say X). If so, you do not need to specify the M-file location for each
constraint block that wraps it but only specify location X in the manner described below.

To specify the parent folder location, follow the steps below:

1) Launch ParaMagic® Settings window in MagicDraw (Options > Environment > ParaMagic Settings),
as shown in Figure 62 below.

2) Specify location of the folder as the value of the variable MATLAB M-File Default Location, as shown
in Figure 62 below.

Environment Dph’o_— E

ParaMagic Settings options
Change various ParaMagic Settings options and configurations.

ParaMagic Settings
By [=] 2=

Bl Core solver and other settings

4P Speling
[ Launchers
E Experience
[B] External Tools
=] Notifications
£ Code Engineering
Document Modeling
. Edipse UML2 {v1.x) XMI
= Edlipse UMLZ (v2.x) XMI
- Edlipse UMLZ (v3.x) XMI
2 Edipse UML2 {v4.x) XML
Er# Enterprise Architect Import

Mg Macros

-
Report Wizard
43 Simulation

Mathematica [ Player Pro
C:\Users\Manas\AppData'Local'. magicdraw\18. 0'plugins\com.intercax. ..

Core Solver

Working Directory

Solver Timeout -1 A
» G e - \Program Files\MagicDraw UML\samples\ParaMagicTutorials\HomeH... |~

Browser Display Predsion -1

Show Stats [T false

Mathematica / Player Pro Kernel C:\Program Files\Wolfram ResearchiWolfram Player Pro\3.0\Mathitern..,

Log Message Level WARNING

Bl Local vs. Remote core solver

Use Local Solver frue
Remnte Snlver - Hnst |IR]

MATLAB M-File Default Location
Location at which ParaMagic will search for MATLAB function/script M-files if their locations are not specified with the constraint blocks.

s manirdram e RNARN

Type here to filter properties

Reset to Defaults

OK ] [ Cancel ] [ Help ]

Figure 62: Specify default location of MATLAB M-files in ParaMagic Settings window

Note: The location of a MATLAB M-file can also be specified with each constraint block that wraps the
M-file.
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Step 3. Specify a timeout for expecting results from MATLAB functions and script executions

The ParaMagic.ini file includes a variable that specifies the timeout interval for ParaMagic™ when
waiting for MATLAB functions and scripts to finish execution. By default, this is set to 180 seconds as
shown below.

com.intercax.xaitools.solver.timeout.in.seconds=180

Users are recommended to specify an upper-bound value for this variable depending on the time typically
taken to execute the MATLAB functions/script that they intend to use with ParaMagic™. Once the
timeout is reached, ParaMagic™ stops expecting results from MATLAB but does not terminate the
MATLAB execution process.

Step 4. Define a constraint block to “wrap” MATLAB script/function M-file

1)

2)

3)

Locate the xfwExternal_Matlab_Script or xfwExternal_Matlab_Function constraint block in the
Constraint Block Library package loaded with the ParaMagic Profile. The former is setup to wrap
script M-files and the latter is setup to wrap function M-files.

Copy the xfwExternal_Matlab_Script or xfwExternal_Matlab_Function constraint block to your
package and rename it (say X).

Double click on the new constraint block X. This will open the Specification window as shown
below.

[ Constraint Block - X
rﬂg Q= = History :| B ® [Crhital] %

B x Parameters
.-[B] Usage in Diagrams .,q: PR

BE B &
DocumentationHyperlinks z* i
onstraints | Mame | Type | Provided Required | Classifier | |
tributes =]

- output O Real [Sys... EH % [orbital]
perations - inputl [H Real [Sys... B x [Orbical]

-- Behaviors ; .
_____ Template Parameters - imput2 [ Real [Sys... B3 % [Orbital]

BB Inner Elements
----- Relations
- Tags

= Language Properties
----- Signal Receptions

Figure 63: Constraint block specification window — constraint parameters view

4) By default, this constraint block is setup to wrap a Matlab M-file with 2 inputs and 1 output.

Add/remove input parameters depending on the number of inputs required by your M-file. Only 1
output parameter is allowed (single-valued or a single-dimensional array). For M-file functions, the
input parameters and output parameters correspond to the arguments passed to and the value returned
by the function. For M-file scripts, the input parameters correspond to those value properties that need
to be passed to the script and the output parameters correspond to those value properties that are to be
populated at the end of the script execution. See section 8.3.1 for specifics related to Matlab scripts.
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5) Click on the Constraints menu in the Constraint Block specification window. By default, a constraint
has been specified. Modify this constraint equation per your requirements. The general format of the
constraint relation is:

<out_param> = xfwExternal(matlab, <script_or_function>, <name_of_ M-file>,
<in_param_1>,...)

where:

- <out_param> is the name of the output parameter (result computed during execution and to be
read back into SysML instance)

- <script_or_function> is set to scriptascii (for MATLAB scripts) or function (for MATLAB
functions)

- <name_of_M-file> is the name of the MATLAB M-file without the extension (.m)

- <in_param_1>,... is a comma-separated list of input parameters (given values to be sent from
SysML instances to MATLAB script/function)

Terms enclosed in < > are variables that can have different names, while those not enclosed in < > are
keywords/constants that should not be changed.

[A Constraint Block - X ®
B 2 & = History:| B x[orhital] |w
B x Constraints
Usage in Diagrams i .
= | ai & g .
-[E] Documentation/Hyperiinks g EEE Profile:

H

Bl Constraints Mame | Spedfication |
Attributes =]

Farameters

Operations
BEhaViUrs
|| Template Parameters

-[E] Inner Elements
B Relations

Taags

-[B Language Properties
B Signal Receptions

output=yfwExternal{matab, soiptasdi, <your_matiab_scrip [
t_name =,input1,input2)

el
(51}

’ Create ] [ Clone ] [ Apply ] ’ Unapply ]

Figure 64: Constraint block specification window — constraints view

For example, Figure 69 below shows a constraint block with five parameters that wraps a MATLAB
M-file script (demoscriptasciisimulink.m). These parameters correspond to the given and computed
variables in the script. For example, values of row, col, outtemp, and daycyc variables are given, and
the value of the variable cost is computed during the script execution.

In ParaMagic®, both input and output parameters of the constraint block wrapping a M-file could be
single-valued or multi-valued (e.g. array).

Step 5. Specify the location of the folder containing the M-file

To specify the location of the folder containing the M-file (to be wrapped by the subject constraint block),
follow the steps below:
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1) Click on the icon highlighted below or double click the constraint specification in the MD
containment tree.

[A Constraint Block - X

E & g = = Hismry:’m‘
B x

Constraints

Usage in Diagrams . .

b 8 - = :
-[B| Documentation/Hyperlinks A a2 Profile: | <ALL> v
Name | Spedification
Attributes =]

Parameters
Operations

Behaviors

Template Parameters

Inner Elements
Relations

Tags

Language Properties
[ Signal Receptions

output=yfwExternal matiab, soriptasci, <your_matlab_scrip
t_name,inputl,input2)

[ Create ] [ Clone ] [ Apply ] [ Unapply ]

Figure 65: Invoking the constraint specification window from the constraint view

2) The action in the previous step will open the specification window for the constraint. Click on the
Tags menu as shown below and select ParaMagic Profile in the Profile list. This will display all
stereotypes (and their tags) that are provided by the ParaMagic Profile for constraints.

[X Constraint - matlab
B % 2 & = History :| {} matlab=output=xfwExternal{matlab,scri... [Crbital: 2]

{1 matlab=output=xfwExternal{m |- Tags
DocumentationMyperlinks ||| oo e

sace in Diagrams ParaMagic Profile ¥ || select tag and dlick Create Value to create new
< < m m{ConstraintBlocks A || value for it.
ner Elements = _ =
DSL Customization

[E-## |MagicDraw Profile
L[Matrix Templates Profile
ModelElements
[Mon-Normative Extensions -

Ports&Flows v

< | b

Figure 66: Specifying the location of M-file - selecting the ParaMagic profile

3) Select the working_dir tag and click on the Create Value button, as shown below.
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[ Constraint - matlab

'ﬂg 2 & = Hlsmry:| {1 matlab=output=xfwE:xternalimatlab, scri... [Orbital::x] V|
{_} matlab=output=xfwExternal(m{|Tags
'- Dowmentation/Hyperlinks

Profile: |ParaMagic Profile V| Property:
Usage in Diagrams _
Inner Elements BS BX =V a3 B3 [working i :Sring | (T )
Relations :
m E-ex < «External_Model>> Select tag and dlick Create Value to

create new value for it.

Constraints

< | >

Figure 67: Specifying the location of M-file — selecting the tag to populate

4) Specify the location of the folder containing the M-file. For example, if the M-file is located under
C:\Data\My_MATLAB_Files, specify the following value for the working_dir tag:
C:\\Data\\My_MATLAB_Files.

[3 Constraint - matlab

% o & = History :| 1} matlab=output=xfwExternal{matlab, scri,. . [Orbital:x] v|

11 matlab=output=xfwExternal{mi | -Tags
DocumentationHyperlinks

Profile: |ParaMagic Profile v| Property:
Usage in Diagrams -
Inner Elements BE B =V 55 E= |:| ]
Relati :
— B-s# <«<External_Model> > Value
kii dir = "4 5 Folder"
: Constraints [=Qworking_dir = "c:', ', 5ome Folder [

C:\\Data\\My_MATLAB_Files ~

v
[Remove\-‘alue] [Edit\-‘alue] T L E]
< | >
Back

Figure 68: Specifying the location of M-file by populating the tag

Note that you only need to specify the location of the folder containing the M-file. The name of the
M-file is specified in the constraint specification.

Step 6. Define constraint properties typed by the wrapped constraint block

After defining a constraint block that wraps MATLAB M-files, constraint properties could be defined for
blocks whose values properties are to be related using the subject MATALB function/script. These
constraint properties should be typed by the constraint block created in Step 4 above. When creating
SysML parametric models using parametric diagrams, the constraint parameters of the constraint property
should be connected to the value properties of the block. For example, as shown in Figure 71, a constraint
property SHH (of type SimulinkHomeHeating constraint block) is defined for a block and its constraint
parameters outtemp, daycyc, row, col, and cost are connected to a block’s value properties
Outdoors.Temp, DailyCycle, OutputRow, OutputColumn, and DailyCost respectively.
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==constraint>=
SimulinkHomeHeating
icost=xfwExternal{matlab scriptascii, demoscriptasciisimulink row col outtemp dayoyc)

parameters
cost : Real
outtemp . Real
daycyc : Real
row ;. Real
col . Real

Figure 69: SysML constraint block to wrap MATLAB scripts

[ constraint Block - SimulinkHomeHeating

% | o= Histnrv:|@Sirnulinld-lnmeHeating[HomeHeating] v|

Ef simulinkHomeHeating Constraints

- Usage in Diagrams , .

- Docgmentatianijperlinks g BT EX Profile:
Constrainks Mame Specification |
Aktributes =
Parameters
Operations matlab
ehaviors

cost=xfwExternal(matlab, scriptascii,
demoscriptasciisimulink, row, col, outtemp, dayoyc)

emplate Parameters
nner Elements
Relations

Tags

anguage Properties
[ signal Receptions Apply

Figure 70: Defining constraint specification for a constraint block to wrap MATLAB script M-file

==constraint==
SHH : SimulinkHomeHeating
{cost=xfwExternal{matlab scriptascii, demoscriptasciisimulink row col outtemp dayecye)
i

col : Real

,_| outtemp : Real daycyec : Real row : Real cost : Real
ed e3 el el
es
OD_Hpme : Outdoors [ |Dai|3rCyl:le:Real o= | |ﬂutputRnw:Real o= | |C!utputColumn:Real o= | | DailyCost: Real |

Temp : Real

Figure 71: SysML constraint property typed by a constraint block (that wraps MATLAB scripts) and used in a
SysML parametric diagram

8.3.1 Using MATLAB scripts

Unlike MATLAB functions, scripts do not have input arguments and output/return values. ParaMagic™
uses intermediate input and output files to transfer SysML instance values (givens) from MagicDraw to a
MATLAB script before executing the script, and to transfer results obtained by executing the script to
SysML instance values (targets). To use MATLAB scripts with ParaMagic™, follow the steps below
after finishing Step 6 above.
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Step 7. Setup script M-file to read/write values from/to SysML instance model

Since MATLAB scripts do not have input and output arguments, users must add commands to the
beginning/end of the script to read/write values from/to SysML instance model. Follow the steps below to
setup your script M-file to read values from input.txt file and write results to output.txt file.

1)

2)

Add commands to achieve the following at the beginning of your script M-file

a) Define an array variable in the MATLAB script that will hold values of input parameters.
b) Load the input.txt file to populate this variable.

c) Assign the values to variables in the script

For example, a variable insel is defined to contain values loaded from input.txt file. Then, four values
contained in the insel variable are assigned to four variables in the script.

inSel= load('input.txt');

ol=inSel(1);
02=inSel(2);
TempOutsite=inSel(3);
Amplitute=inSel(4);

Note that the order in which the values are written to the input.txt file is the order in which input
parameters are listed in the constraint specification of the constraint block. As an example, for the
constraint block in Figure 69, the input.txt will contain values of the variable in the following order:
row, col, outtemp, daycyc.

Add a save command at the end of your script M-file to save the value of the solved variable—
corresponding to the output parameter of the constraint property—in output.txt file. For example, to
save the value of variable a, the following command is used.

save('output.txt','a’,'-ASCII'");
exit

The exit command ensures that the MATLAB session ends after script execution. This will avoid
having multiple sessions of MATLAB running as the SysML model is solved multiple times.

ParaMagic™ writes SysML instance values corresponding to the input parameters of a constraint property
to a text file (input.txt) located in the same folder as the MATLAB script M-file. To import the value of
the variables computed from script execution to the SysML instance model, ParaMagic reads a text file
(output.txt) containing the variable value and located in the same folder as the MATLAB script M-file.
Users do not need to worry about the input.txt and output.txt files created for transferring values
between MagicDraw and MATLAB. These are automatically created and managed by ParaMagic™.
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8.3.2 Using MATLAB functions

For using ParaMagic™ with M-file functions, ensure that in Step 4 above, the constraint specification—
for the constraint block that wraps the M-file function—uses the keyword function (as shown below)
instead of scriptascii.

<out_param> = xfwExternal(matlab, function, <name_of_function_M-file>, <in_param_1>,...)

Figure 72 and Figure 73 below illustrate an example of a MATLAB function (DemoAddition) with 2
input parameters wrapped in a constraint block, which is then used to type constraint properties in a
SysML parametric model.

<<constraint=>
DemoAddition_MatlabFunction
{z=xfwExternal(matlab function DemoAddition,x,y)}

parameters
X : Real
y: Real
z: Real

Figure 72: SysML constraint block to wrap MATLAB function

lipartz : Component2 gw 7par'tv‘i ﬁréomponerﬁi'gi
‘ “'P“CZ:Real () f{vp101:Real ) l
4”|'lp1':"Real = |
x : Real ' TE: Real y : Real
L] LT ‘

<<constraint>>
cp1: DemoAddition_MatlabFunction
{z=xfwExternal(matlab function DemoAddition x,y)}

Figure 73: SysML constraint property typed by a constraint block (that wraps a
MATLAB function) and used in a SysML parametric diagram

Follow the step below after completing Step 6 above.
Step 6. Export return values to an output.txtfile.

Add a save command at the end of the MATLAB function to save the value of the output/return variable
in output.txt file. The code snippet below shows the save and exit commands added at the end of the
definition of function DemoAddition in a function M-file.

function z = DemoAddition(x,y)
z=x+y;

save('output.txt', 'z', '-ASCII")
exit

Note that functions can have input arguments and hence PM-MC does not require users to read values
from an input.txt file (as in scripts). In the example below, the save command is added at the end of a
function DemoAddition that returns the sum of two numbers. The sum is saved to output.txt file. As in
the case of scripts, input parameters and return values of M-file functions could be single-valued or a
multi-valued (e.g. array) but they cannot be complex data structures (such as an array of arrays, etc.).
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9 TRADE STUDIES

With ParaMagic®, users can easily setup and run trade studies on their existing SysML models. The
capability to run trade studies on SysML parametric models allows users to compute performance,
reliability, cost, and other measures-of-effectiveness—especially those used to verify requirements—for a
large set of system alternatives at each development phase, and then select the best-in-class alternatives
for the next development phase. With ParaMagic®, trade studies can be now be performed from the
earliest stages of system development. The overall process for setting up and running trade studies is as
below.

1. Verify that your existing SysML instance model can be solved using ParaMagic®.
2. Setup a trade study

a. ldentify trade study inputs, outputs, and constants.

b. Link inputs and outputs to Excel spreadsheets. ParaMagic® reads values of trade study input
variables for all scenarios from linked Excel spreadsheets. After completion, the values of trade
study output variables for all scenarios are written to the linked spreadsheets.

c. Specify number of scenarios

3. Run trade study

9.1 Operation

The detailed steps for setting up and running trade studies on SysML models are as follows. The process
described below assumes that you have setup a SysML schema and instance model in the same manner
that you do for regular ParaMagic® solving purposes—see the Tutorials document for details.

Step 1. Verify that your SysML instance model can be solved in ParaMagic®

The series of steps below are used to check if your SysML schema and instance models are structurally

valid can be solved. Solving an instance model is similar to running a single scenario in a trade study.

1) Browse the instance model: Right click on the instance package and select ParaMagic — Browse. If
the ParaMagic browser opens up, this implies that the schema and instance are structurally valid.

2) Solve the instance model: Click on the Solve button in the ParaMagic® browser. See section 7.1 for
details. If the model solves correctly, it implies that your instance model

3) Update SysML instance model: Click on the Update to SysML button in the browser. Check that the
target slot values are updated in the SysML instance model.

Step 2. Prepare Excel spreadsheet(s) with values of trade study input variables
1) Trade study variables are arranged in columns, and the scenarios are specified in rows.

All values of a trade study input variable should be in columns, such that each row in those columns
contains values for a single scenario. In the spreadsheet shown below, NumPlanes, NumCrew, and
Fuel Supply / day are the trade study input variables, and Miles scanned / 24 hrs is the output
variable. Note that values for input/output variables are in columns. Each row, starting with row 3,
represents the different trade study scenarios that will be solved using ParaMagic®.

A B [s D

1 Scenarios Num Planes Num Crew Fuel Supply / day Miles scanned / 24 hrs
2

3l 1 3 4 200

4 2 3 4 250

5 3 3 4 300

8 4 3 4 350

7 5 3 4 400

] 5 3 ] 200

9 7 3 ] 250

Figure 74: Trade study scenarios must be organized in rows—one scenario per row
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For multi-valued variables (e.g. arrays), the values for each scenario should be in contiguous
columns. For example, the values of Input Variable 1 and Input Variable 2 are arranged in columns
for each scenario. Hence for scenario 1, Input Variable 1 = {1,2,3} and Input Variable 2 = {1,1,1}.

A B 5 D E F G H I J L M

1

2 | Scenarios Input Variable 1 Input Variable 2 Output Variable 1 Output Variable 2 |
3 [ 1 1 2 3 1 1 1 |
4 2 4 5 8 2 2 2

5 3 7 8 9 3 3 3

6 4 10 11 12 4 4 4

7 5 13 14 15 ] ] ]

8 6 16 17 18 6 6 ]

E] 7 19 20 21 7 7 7

10 8 22 23 24 8 8 8

Figure 75: Values of multi-valued variables are specified in contiguous columns for each scenario

2) Trade study variables may be linked to different workbooks/worksheets, and may have the first
scenario specified in different rows for each variable, unlike as shown in the figures above.

Step 3. Connect trade study variables to Excel spreadsheets
ParaMagic uses the following logic to identify trade study input and output variables, and constants:

Slots with causality “given” and Excel access mode “Read” are treated as trade study input variables.
Slots with causality “target” and Excel access mode “Write” are treated as trade study output

a)
b)

c)

variables.

Slots with causality “given” but with no connection to Excel are treated as trade study constants.
Hence, the value(s) specified for these slots are repeated for each trade study scenario.

Causalities were assigned to all slots in Step 1 above. In this step, you will link slots corresponding to
trades study inputs and output to Excel spreadsheets. To do this, follow the steps below:

1) Launch Excel setup: Right click on the instance package and select ParaMagic — Excel — Setup. This
will launch the Excel setup utility, as shown below.

-
E-=
EH = Aircraft0l
i (B DutyCycle_CameraRefit
- (Z DutyCycle_Mainkznance
i (3 DutyCyde_Plane
- (Z DukyCycle_Turnaround
i (3 NumberAvailablePlanes
- (Z3 NumberAvailablePlanesByDay
i (2 Number AvailablePlanesByMight
(S MumberDayCameras
i (2 NumberNightCameras
i (2 Numberplanes
B3 Fuel0l
i~ (@ DailyFuel oadPerPlane
b B FuelsupplyPerDay
: (S NumberavailableFuelLoads
EH = Crewdl
L (@ CrewTimeon
- (Z3 NumberAvailableCrews
L. (@ NumberCrews
- E) MilesScannedPerHour
- & MumberAvailableCraws
- (E) MumberavailableFuelLoads
- & MumberAvailablePlanes
-~ (Z) MumberavailableSystems
& MumberMiesScannedPer24Haours

Worksheet Selection

Workbaok File

Worksheet

o] (o ]

Clear

[

OK

] [ Cancel ] [ Apply

)

Figure 76: Use the Excel setup utility to link trade study inputs and outputs to spreadsheets

2) Connect trade study inputs/outputs to Excel spreadsheets: To do this, follow the steps below for each
slot corresponding to a trade study input or output variable.
a) Click on the slot in the instance tree on the left pane.
b) Specify the Excel workbook and worksheet that contains scenario values for this slot, as shown in

Figure 77 below.
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E-= Syskem0l Y

53 Arcraftol [] Use Default Worksheet
1 ircral

----- 2 DukyCycle_CameraRefit Warkhook File  |LittleEye_TradeStudy_Scenarios, xlsx
----- 2 DukyCycle_Maintenance
----- {2 DukyCycle_Plane Worksheet TS_AllVariables b’
----- 2 DukyCycle_Turnaround
----- {2 NumberAvailablePlanes cell Selection
----- 2 MumberAvailablePlanasE:
----- 2 MumberAvailablePlanasE: Cell Range B3
----- = NumberDayCameras
----- = NumberMightCameras Access Mode (%) Read O Write © Nene
----- 8
- = Fueldl

----- =) DailyFuelLoadPerPlane
----- =) FuelSupplyPerDay

— (2 NumherAvailahleFell n;r b l oK ] l Cancel ] l Apply ]

Figure 77: Use the Excel setup utility to link trade study inputs and outputs to spreadsheets

c) Set the cell range to the cell(s) that contain value(s) for the first scenario. For single-valued slots,
the cell range is a single cell. For multi-valued slots, the cell range is a set of contiguous cells in a
single row. As shown above, the cell range for NumberPlanes is set to B3 (spreadsheet shown in
Figure 74). Similarly, the cell range for Input Variable 2 and Output Variable 1 (spreadsheet
shown in Figure 75) would be E3:G3 and H3:33 respectively.

d) Set the access mode to
i) Read for slots corresponding to trade study input variables.
ii) write for slots corresponding to trade study output variables.

e) Click on the Apply button.
Since trade study input/output variables are setup to read/write from Excel, they are shown in
blue/red color, as shown in Figure 78 below. For more details on how to use the Excel setup
utility (PM-EC feature), refer to section 8.2.

ELE] Workshest Selection
B} =1 Aircraftol
S DutyCyclz_CameraRefit Warkhook File _m
i3 DutyCyclz_Maintenance
i+ DutyCycle_Plane Warkshest h

i+ (@ DutyCycle_Turnaround
£ (S0 NumberdvailablePlanes
-2 NumberavaiablePlanesByDay
i (Z» NumberAvailablePlanssByhight
(S NumberDayCameras
£ B NumberMightCameras
L2 NumberPlanes
=1 Fuelot
i (S0 DallyFuslLoadPerPlane
L FuelSupplyPerDay
LB NumberavailableFuelloads
B = Crew01

30 CrewTimeOn

S NumberivailablzCraws

L. NumberCrews
- (B MilesScannedParHaur
{2 Numberdv ailableCraws

S NumberivailableFuslLoads

E» NumberavailablzPlanss
(2 NumberAvailableSystems
(& NumberMilesScannedPer 24Hours

[ oK l [ Cancel l [ Apply ]

Figure 78: Slots setup to read (write) from Excel are shown in blue (red) color
Step 4. Specify number of scenarios

Right click on the instance package and select ParaMagic — Trade Study — Setup. Specify the number of
scenarios in the dialog box, as shown below. The value (say n) specified for the number of scenarios will
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be used by ParaMagic® to construct n scenarios by reading the values in n rows (in spreadsheets
connected to input variables) starting with the first row specified for each input variable.

Number of Scenarios

125 [ ok ][ cancel |

Figure 79: Specify number of scenarios for a trade study

Step 5. Run trade study

Ensure that all spreadsheets connected to trade study output variables are closed. Then, right click on the
instance package and select ParaMagic — Trade Study — Run. The trade study progress window (as
shown in Figure 80) indicates the specific scenario being run and the core solver being used.

i) Trade Study in progress... [F=REE

Running scenario 1/20...
Solving using Mathematica / Player Pro via local machine. ..

Figure 80: Trade study progress window

) ParaMagic Information S5

':0:' Trade study completed.

- _________
Figure 81: Message to indicate completion of a trade study
Completion of a trade study is indicated by the message above (Figure 81).

Step 6. View trade study outputs and perform post-processing

Open spreadsheets connected to trade study output variables to see results. You can use Excel for post-
processing the values, such as for computing statistical metrics or plotting output variables against input
variables.

Note that trade studies can be performed with either Mathematica or OpenModelica as a core solver.

SysML parametric models executed in trade studies may include all types of relations as solved using

regular ParaMagic® operation except for custom Mathematica relations that create plots for each
21

scenario”.

Parametric models executed during trade studies could be using constraint blocks wrapping MATLAB M-
files (section 8.3) and custom-defined Mathematica functions (cMathematica — section 8.1).

2 p|ots created for a scenario will overwrite those created for the previous scenario.
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9.2 Limitations
The trade study capability in ParaMagic® has the following limitations:

1)

2)

3)

4)

A trade study is based on a SysML instance model which represents the structure of all scenarios. The
scenarios may differ in the values assigned to the slots but not the number of instances in the SysML
instance model. Figure 82 illustrates a simple SysML schema model that represents a system
composed of 1 or more parts. The figure also shows a SysML instance model that conforms to the
schema model. The instance model represents a system (system101) with 4 components. If one were
to setup a trade study for this example, it would be setup for the instance model. All scenarios will
represent systems with 4 components. The scenarios may vary in slot values, i.e. the values of the
slots max_length, part_number, and weight (of the component instances comp1, comp2, comp3, and
comp4) may be different in the scenarios.

zhlock= zhlocks = |
System em101 : em
values components = compl, comp2, comp3, compéd
weight : Real weight=""
ahlockz ahlocks
-components |1.* comp1 : Part comp3 : Part
zhlocks max_length="" max_length=""
Part part_number="" part_number=""
T weight = weight =
weight ; Real
max_length | Real
part_number : String ablocks ablocks
comp? : Part compd : Part
max_length="" max_length=""
part_number="" part_number=""
weight="" weight=""
SysML Schema SysML Instance structure

Figure 82: Trade studies in ParaMagic™ work on a fixed SysML instance structure

Values of trade study input variables must be explicitly specified for all scenarios in Excel
spreadsheets. Specification of values as intervals and automated generation of scenarios by creating
combinations of these intervals is not supported in this version of ParaMagic®.

Trade study runs are functionally similar to batch execution of a set of pre-defined scenarios.
Automated generation of scenarios based on techniques to explore the design space is not supported.
Contact us (info@intercax.com) for tailored interfaces to commercial tools, such as Isight®* and
ModelCenter?, that provide design space exploration and optimization capabilities.

Plotting capabilities, such as the generation of single factor plots, interaction effects matrix plots, and
carpet plots for trade studies, are not available natively with this version of ParaMagic®. Since trade
study outputs are written to Excel spreadsheets, users may leverage the extensive plotting and post-
processing capabilities of Excel.

22 Isight: http:/Aww.simulia.com/products/isight.html
2 ModelCenter: http://www.phoenix-int.com/software/phx_modelcenter.php
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10 PARAMAGIC® SILENT (NEW)

The ParaMagic® Silent feature is being introduced in this version (ParaMagic® 18.0). It allows users to
invoke ParaMagic® in silent mode from their MagicDraw plugins if they have ParaMagic® plugin
installed with a valid license. The ParaMagic® Silent feature provides two main automation capabilities,
as listed in sections 10.1 and 10.2 below.

10.1 Invoking ParaMagic® in silent mode from plugins

This capability allows users to invoke ParaMagic® in silent mode from their own MagicDraw plugins.
Here, “silent mode” implies that ParaMagic® can be used to validate and solve SysML parametric models,
and update the SysML instance model with solved results without launching the ParaMagic® browser Ul.

10.1.1 Java API calls to invoke ParaMagic® Silent

To invoke ParaMagic® in silent mode from your MagicDraw plugins, follow the steps below. A demo
plugin with source code is provided with ParaMagic® to illustrate this feature. See section 10.1.2 for
details.

(1) Add the jar files in MagicDraw lib folder (<MD_Root>\lib) to your classpath. You may have already
done this for your plugin/script development.

(2) Add the icax_paramagic.jar file to your classpath. This file is located in the ParaMagic® plugin
installation folder, e.g. <MD_Root> \plugins\com.intercax.paramagic\icax_paramagic.jar

(3) Add the pb_logging.xml file under your source (src) folder. This file is the log4j configuration for
logging messages when running ParaMagic® Silent and is provided with the demo plugin (see section
10.1.2).

(4) Inyour code, import the ParaMagic_Silent class, as below:
import com.intercax.paramagic.plugin.slient.ParaMagic_Silent;

(5) The ParaMagic_Silent class provides the following three static methods.
com.intercax.paramagic.plugin.slient.ParaMagic_Silent

public class ParaMagic_Silent extends java.lang.Object

Constructors:
ParaMagic_Silent()

Methods:
Modifier and Type Method and Description
static boolean validate(com.nomagic.uml2.ext.magicdraw.classes.mdkernel.Instan

ceSpecification is, java.io.File logFile,
int doneCheckingIntervalInMillSeconds)

When invoked on a SysML instance specification, this method validates the
instance structure, associated block structure, and parametric models.
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Parameters

is
SysML instance specification that is validated

logFile

file where log messages are written out. If null, log messages will be written
out to the paramagic_silent.log file in the ParaMagic working folder, e.g.
C:\Users\<Your
Account>\AppData\Local\.magicdraw\18.0\plugins\com.intercax.paramagic
on Windows 7

doneCheckingIntervalInMillSeconds

time interval in milliseconds after which ParaMagic continuously checks if the
validation is done.

Returns

true if validation is successful, false otherwise

static
java.util.Map<java.lan
g.String,
java.lang.Object>

validateAndSolve(com.nomagic.uml2.ext.magicdraw.classes.mdker
nel.InstanceSpecification is, java.io.File logFile,
int doneCheckingIntervalInMillSeconds)

When invoked on a SysML instance specification, this method validates the
instance structure and the associated block structure, and solves the
parametric model for that instance.

Parameters

is

SysML instance specification that is validated and for which the parametric

model is solved. When working with ParaMagic® in plugin mode, this is the
instance for which you launch the solve action (ParaMagic > Browse, press
Solve).

logFile

file where log messages are written out. If null, log messages will be written
out to the paramagic_silent.log file in the ParaMagic working folder, e.g.
C:\Users\<Your
Account>\AppData\Local\.magicdraw\18.0\plugins\com.intercax.paramagic
on Windows 7

doneCheckingIntervalInMillSeconds

time interval in milliseconds after which ParaMagic continuously checks if the
solving is done and results are available.

Returns

Map whose keys are the MagicDraw ids of the instance slots, and values are
solved values resulting from parametric model execution. The map includes
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ids of only those slots that have been solved (causality=target/ancillary).

For single-valued primitive slots, the value (Object) is a Number
object Number. A null value indicates that the solving was unsuccessful.

For multi-valued (array) primitive slots, the value (Object) is a List of Number
objects and includes all values irrespective of their causality (target, ancillary,
undefined, or given). A null value in the list either represents a slot value that
was not required to be solved (causality=undefined) or could not be solved
(causality=target).

If the map is null or empty, it indicates that there was an error, such as due
to license validation, model validation, or solving. Refer to the logFile for
details.

static
java.util.Map<java.lan
g.String,
java.lang.Object>

validateAndSolveAndUpdate(com.nomagic.uml2.ext.magicdraw.clas
ses.mdkernel.InstanceSpecification is, java.io.File logFile,
int doneCheckingIntervalInMillSeconds)

When invoked on a SysML instance specification, this method validates the
instance structure, associated block structure, and parametric models; solves
the parametric model for that instance; and updates the SysML instance
model with the solved results.

Parameters

is

SysML instance specification that is validated and for which the parametric
model is solved. When working with ParaMagic® in plugin mode, this is the
instance for which you launch the browse, solve, and update action
(ParaMagic > Browse, press Solve, press Update to SysML).

logFile

file where log messages are written out. If null, log messages will be written
out to the paramagic_silent.log file in the ParaMagic working folder, e.g.
C:\Users\<Your
Account>\AppData\Local\.magicdraw\18.0\plugins\com.intercax.paramagic
on Windows 7

doneCheckingIntervalInMillSeconds
time interval in milliseconds after which ParaMagic continuously checks if the
solving is done and results are available.

Returns

Map whose keys are the MagicDraw ids of the instance slots, and values are
solved values resulting from parametric model execution. The map includes
ids of only those slots that have been solved (causality=target/ancillary).

For single-valued primitive slots, the value (Object) is a Number
object Number. A null value indicates that the solving was unsuccessful.
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For multi-valued (array) primitive slots, the value (Object) is a List of Number
objects and includes all values irrespective of their causality (target,
ancillary, undefined, or given). A null value in the list either represents a slot
value that was not required to be solved (causality=undefined) or could not
be solved (causality=target).

If the map is null or empty, it indicates that there was an error, such as due
to license validation, model validation, or solving. Refer to the logFile for
details.

static boolean validateAndRunTradeStudy(com.nomagic.uml2.ext.magicdraw.class
es.mdkernel.InstanceSpecification is, java.io.File logFile,
java.io.File resultFile, int doneCheckingIntervalInMillSeconds)

When invoked on a SysML instance specification that is setup for trade
studies, this method validates the instance structure, associated block
structure, and parametric models; and runs the trade study for that instance.

Parameters

is

SysML instance specification that is used as a template for running the trade
study. When working with ParaMagic® in plugin mode, this is the instance
for which you launch the trade study action (ParaMagic > Trade Study >
Run).

logFile

file where log messages are written out. If null, log messages will be written
out to the paramagic_silent.log file in the ParaMagic working folder, e.g.
C:\Users\<Your
Account>\AppData\Local\.magicdraw\18.0\plugins\com.intercax.paramagic
on Windows 7

doneCheckingIntervalInMillSeconds

time interval in milliseconds after which ParaMagic continuously checks if the
trade study is done.

Returns

true if successful in running the trade study, false otherwise

Methods inherited from class java.lang.Object
equals, getClass, hashCode, notify, notifyAll, toString, wait, wait, wait

(6) If your ParaMagic® license has expired and you try to invoke the static methods in ParaMagic_Silent,
they will return false and you will see the following message written out to the ParaMagic Silent log
file.

2014-08-07 16:42:40 WARN - ParaMagic plugin license has expired. Contact your administrator or No Magic to
renew your license.
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10.1.2 Install, Test, and Review the ParaMagic Silent Demo plugin

A demo plugin with source code is provided with ParaMagic® to illustrate how to invoke the ParaMagic®
Silent feature. It is located in the Other Examples folder (section 5.3) after the ParaMagic® plugin
installation:

e Folder: <MD_Root>\samples\ParaMagic\Other_Examples\

e File: com.intercax.paramagic.demo.zip

Follow the steps below to review and test the demo plugin.

1) Extract the demo plugin zip file - com.intercax.paramagic.demo.zip. It will create a new folder with
the same name (com.intercax.paramagic.demo) which will have the following contents.

J :\Instalations\MagicDraw_18.0\plugins\com.intercax.paramagic.demo « | +4

lit View Tools Help

L Include in library - Share with = Burn MNew folder == » 0 I@I
Name ‘ Date modified Type Size
| 5IC 8/7/2014 10:52 AM File folder
%] icax_paramagic_demo.jar 11/10/2014 2:38 PM Executable Jar File 9 KB
=] plugin.xmi 11/10/2014 1:18 AM ¥ML Document T | ek e
to preview.

Figure 83: Contents of the ParaMagic Silent Demo plugin

2) To view the source code, see the src folder. It includes the following:

a) pb_logging.xml file is the log4j configuration file that is need for configuring ParaMagic Silent
logging. It should be included in the src folder of your MagicDraw plugins and scripts.

b) ParaMagicDemoPlugin.java class under com\intercax\paramagic\demo\plugin folder. This
single class has the plugin definition, including the actions. See the nested class
ParaMagic_SilentThread that is instantiated and run from the actionPerformed(..) method of
ParaMagicSilentAction class

3) Copy the folder com.intercax.paramagic.demo to the MagicDraw plugins directory, e.g.
<MD_Root>\plugins. Close and restart MagicDraw as an Administrator. This will install the demo
plugin.

4) Open any sample model that comes with ParaMagic®, e.g. LittleEye model in the Tutorials folder.

Right click on the coverageAnalysis instance and you can see ParaMagic Silent Demo plugin with
two menus.
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Figure 84: Demo plugin to illustrate the use ParaMaQi'(':® Silent feature

a) Plugin Validate->Solve->Update will invoke the validateAndSolveAndUpdate(...) method listed
in section 10.1.1 for a given instance.

If the solving is successful, an information window will indicate so (Figure 85 — top). Once the OK
button is pressed, results will be written out to the MagicDraw notification window, as shown below
(Figure 85 - bottom), in the format <slot id>, <slot name>, <slot value after solving>. For example,
try invoking the menu on the LittleEye::Instance02::coverageAnalysis instance in the LittleEye
model available under the ParaMagic® tutorials.

r i
Information —— ==

ParaMagic Silent ran successfully.

3% Zoom | [ Documentation Properties” [ Motification Window
Motification Window o
® & % =BG
[2014.4140:13:31:54) _18_0_39e018b_1407290130370_249529_19103, coverageAnalysis littleEyeSystem. littleEyeCrew.numberAvailableCrews, 2.1
[2014.11. _18_0_39e018b_1407326143324_126591_12901, coverageAnalysis littleEyeSystem.littleEyeAircraft. numberAvailablePlanesByDay, 3.0
[2014.11. _18_0_39e018b_14072980130376_581042_19115, coverageAnalysis littleEyeSystem.littteEyeAircraft numberAvailablePlanes, 2.403401
[2014.11. _18_0_39e018b_1407290130374_4041_19111, coverageAnalysis littleEyeSystem littleEyedircraft. dutyCycle_Plane, 0.686686
[2014.11. _18_0_39e018b_14072980130378_597694_19117, coverageAnalysis littleEyeSystem.littteEyeAircraft numberAvailablePlanesByNight, 4.0

[2014.11.
[2014.11.
[2014.11.

_18_0_39e018b_1407290130355_107016_19084, coverageAnalysis.numberMilesScannedPer2z4Hours, 2016.0
] _18_0_39e018b_1407290130357_688537_19082, coverageAnalysis.numberAvailableSystems, 2.1
] _18_0_39e018b_1407290130368_893544_19099, coverageAnalysis littleEyeSystem.litleEyeFuel.numberAvailableFuelLoads, 5.0

Environment| Project

Figure 85: Result of invoking Plugin Validate->Solve->Update menu on the coverageAnalysis instance in the
LittleEye tutorial model.
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b) TradeStudy Plugin Validate->Solve->Update will invoke the validateAndRunTradeStudy(...)
method listed in section 10.1.1 for a given instance that has been setup to run trade studies. For
example, try invoking the menu for the LittleEye::Instance02::coverageAnalysis instance in the
LittleEyeTradeStudy model available under ParaMagic® tutorials. The following message (Figure
86) will be shown and the trade study results will be written out to the Excel spreadsheet setup
with the instance model—LE_Trade.xIsx available with the LittleEyeTradeStudy model (Figure
87). For more details on ParaMagic® trade studies, refer to section 9.

. I
Information ‘ ﬁ

Figure 86: Message indicating the successful completion of trade study run.

CE 2~ o | = o N crosoft Excel N — [F=REE50)
Home Insert Page Layout Formulas Data Review View Ll e o eE 23
c2 - fe | 1612.8 v
A B c D E F G H 1 J kK [F
MNumber of Planes Mumber of Crews  Miles Scanned Per 24 Hours ]
i 3 4 1613
a 4 1613 Miles Scanned Per 24
5 4 1613 H(:)urs
6 4 1613 3000
7 4 1613
I 3 5 1978)
I a 5 2016
I 5 5 2016
| 6 5 2016 2500
1 7 5 2016
I 3 B 1978)
4 B 2307 =
5 § 2419 5000 A
6 B 2415
7 B 2415
3 7 1978)
4 7 2307
5 7 2637 1500 T T T T T 1
6 7 2829 2 3 4 5 6 7 8
7 7 22 Number of Planes
= i Crews =5 Crews 6 Crews =7 Crews

24
Figure 87: Trade study results are written out to the Excel spreadsheet setup with the trade study instance model.

10.2 Invoking ParaMagic® in silent mode from the ParaMagic® plugin

ParaMagic® can be invoked in silent mode from the ParaMagic® plugin itself. This is useful when users
want to solve and update the SysML instance model with a single mouse click without launching the
ParaMagic® Browser. See the command menus: ParaMagic > Util > Silent > Solve and ParaMagic > Util
> Silent > Solve and Update described in section 7.1.
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11 COPYRIGHT

11.1 Copyright statement from InterCAX LLC

This User Guide and the software described therein are copyrighted. No part of this user guide or the
described software may be copied, reproduced, translated, or reduced to any electronic medium or
machine-readable form without the prior written consent of InterCAX LLC.

11.2 Liability disclaimer from InterCAX LLC

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNERS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.
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